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About this information product

Purpose

Reason for reissue

Safety labels

Intended audience

How to use this
information product

365-314-107R1.1
Issue 1, July 2002

This preface provides an overview of this information product, which
is the Navis™ Optical Provisioning Manager (PM) - Network
Provisioning (NP) Maintenance Guide, Release 1.1.

The purpose of this Maintenance Guide is to instruct users how to
maintain the Navis™ Optical PM - NP Release 1.1 and the network.

Issue 1 of this Maintenance Guide is a new document that supports
Navis™ Optical PM - NP Release 1.1.

This document does not use safety labels.

This document is written for operations personnel who will be
maintaining Navis” Optical PM - NP.

This document contains;

e task information, which includes maintenance tasks (that is,
step-by-step instructions).
» conceptual information, which is specific data related to tasks.

Lucent Technologies Xi
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About this information product

Both types of information is presented within the chapters of this
Maintenance Guide.

Chapter descriptions

The following table describes the information in each chapter of this
Maintenance Guide.

Section Title

Preface About this information
product

Chapter 1 Chapter 1, “Maintenance
Overview”

Chapter 2 Chapter 2, “Fault
management tasks’

Chapter 3 Chapter 3, “Performance
monitoring tasks’

Chapter 4 Chapter 4, “Alarm
management concepts’

Chapter 5 Chapter 5, “Fault
management fault lists”

Chapter 6 Chapter 6, “Performance
monitoring parameters’

Chapter 7 Chapter 7, “Reports
M anagement”

Index Index

Conventions used

Description

Explains this document’s purpose and intended
audience, and how to use the information product.

Describes how maintenance is performed for Navis™
Optical PM - NP.

Explains how to set up and use fault management.
Explains how to set up and use performance
monitoring.

Explains how alarms are collected and managed.
Lists the supported alarms.

Describes the performance monitoring parameters.

Describes reports that can be run.

Enables the user to quickly find information on specific
topics.

This Maintenance Guide uses the following typographical conventions

to distinguish between computer input and output.

«  When describing the Navis™ Optical PM - NP software, fields in
windows and field entries are identified with this font.

e When describing the UNIX® environment, text and numbers that
the user inputs to the computer are identified with boldface

type.

* Inthe UNIX environment, text and numbers that the computer

Related documentation

outputs to the user are identified with monospace type.

This Maintenance Guide is part of a set of documents that supports
Navis” Optica PM - NP,

365-314-107R1.1
Issue 1, July 2002

Lucent Technologies



Maintenance Guide

About this information product

List of documents

The document set that supports Navis™ Optical PM - NP comprises:

1. Navis™ Optical PM - NP Getting Sarted Guide, (365-314-105):
provides information useful to first-time users of the Navis™
Optical PM - NP software. It describes how to start and stop
Navis™ Optical PM - NP, how to use the software, and how to
interpret the graphical user interface.

This document includes tasks and conceptual information.

2. Navis™ Optical PM - NP Provisioning Guide, (365-314-106)
instructs users how to use Navis™ Optical PM - NP to provision
network equipment. This document includes tasks and conceptual
information.

3. Navis™ Optical PM - NP Maintenance Guide, (365-314-107)
instructs users on how to maintain Navis™ Optical PM - NP and
the network.

4. Navis™ Optical PM - NP Administration Guide, (365-314-108)
instructs users on how to administer Navis™ Optical PM - NP
and the network.

This document includes tasks and conceptua information.

Glossary

The Navis™ Optical PM - NP Administration Guide contains a
glossary that will be helpful to users of Navis™ Optical PM - NP,

On-line documentation

On-line documentation for Navis™ Optical PM - NP is provided in
two formats:

1.

An on-line version, in HTML format, of this document set is
provided as part of theNavis™ Optical PM - NP software.

2. Anon-line version, in HTML format, of this document set is
available on CD-ROM.
Navis™ Optical PM - NP User Documentation CD-ROM,
(365-314-109) - includes the full set of documents listed above.
Screen help

The Navis™ Optical PM - NP software includes screen help for each
form, which describes the purpose of the form, each field, and each
button.

365-314-107R1.1
Issue 1, July 2002
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How to comment

How to order

About this information product

To comment on this information product, go to the Online Comment
Form (http://www.lucent-info.com/comments) or email your comments
to the Comments Hotline (ctiphotline@lucent.com).

To order Navis™ Optical PM - NP information products, contact your
Lucent Technologies customer team representative or contact Lucent
Technologies at:

e From the United States, call 888-LUCENTS, prompt 1.
*  From Canada, call 317-322-6619.
e From Europe, the Middle East, and Africa, call 317-322-6416.

* From Asia, the Pacific Region, China, the Caribbean, and Latin
America, call 317-322-6411.

Lucent Technologies 365-314-107R1.1
Issue 1, July 2002



Lucent Technologies
Bell Labs Innovations

1 M al ntenance Overview

Overview

Purpose

Contents

This Maintenance Guide describes the fault management and
performance monitoring components of Navis™ Optical PM - NP. This

chapter provides an overview of the Navis™ Optical PM - NP fault

management and performance monitoring processes.

Section |: Fault management

Fault management overview

Fault management operational mode

Fault management forms

Accessing fault management information from the
Network Map
Color-coded alarm notification on Network Map

Color-coded alarm notification on fault management

forms

User settings
Installation options

Optical Network Navigator

Section |1: Performance monitoring

Performance monitoring overview

365-314-107R1.1
Issue 1, July 2002
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Section |: Fault management

Overview
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Section |: Fault management

Maintenance Overview

Fault management overview

Introduction

Process overview

Element management
systems

The fault management subsystem of the Navis” Optical PM - NP
receives and processes the alarms on the network in real time. It
supports a network operator in achieving the following high level
godls:

* Locating and repairing faults in the network
* ldentifying the impact of failures in the network on services
* Initiating service restoration, if appropriate

Fault management combines the functionality of multiple Navis™
Optical PM - NP modules to process and analyze alarms generated
from the managed network elements.

1. Alarm events are first filtered by the EMS.

2. Filtered events are passed to Navis" Optical PM - NP for
analysis.

3. The analysis determines whether there is a problem within a
network element or a problem on the connection between
network elements.

4. Connection problems are sectionalized down to the link level.
Network element alarms are pinpointed down to the slot or port
level.

5. To dert the user to the alarm condition:

* A Network Event Summary form appears and is dynamically
updated.

*  Network Map links and nodes change color.
*  Various forms are populated with alarm information.

Navis™ Optical PM - NP provides fault management through the
following element management systems (EMSs):

« Navis"” Optical Element Management System (EMYS)

Lucent Technologies 365-314-107R1.1
Issue 1, July 2002



Section I: Fault management Maintenance Overview
Fault management overview

Network elements  Fault management is a powerful tool that utilizes the forwarded
alarms from the EMSs that have received and processed the alarms
from the following network elements:

e Lambda UNITE MultiService Switch Release 2.0

«  Metropolis” EON Release 8.0 and 8.1

«  Metropolis” DMXpress Release 1.0

«  Metropolis” DMXpress Access Multiplexer Release 2.0 and 2.1
«  WaveStar® BandWidth Manager Release 4.1

* WaveStar® OLS1.6T Release 6.1

« WaveStar® TDM 2.5G/10G Release 6.0

Functionality ~ The fault management functionality consists of the following:
* Alarm collection
*  Alarm classification
* Alarm correlation
*  Fault state determination
 Alarm and alarm trail suppression
e Service impact assessment

* Identification of problem location internal and external to the
network

*  Processing of TCAs (Threshold Crossing Alerts)
 Alarm deletion
*  Network Map and screen display colors for alarm notification

Alarm setting  To prevent a flood of alarms, the following overall settings must be
recommendations  set as “not reported” for each network element.

* AIS (Alarm Indication Signal)

 TTP (Trall Termination Point)

*  SSF (Server Signd Fail).

For existing protected connections terminating on network elements
that support per-instance reporting, the aarms must be turned on at

the trail termination points. If the user aso has connections where the
end points are not visible, the user can set AlS to be reported on the

365-314-107R1.1 Lucent Technologies 1-5
Issue 1, July 2002
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Fault management overview

domain boundary termination points. These alarms should not be
turned on for unprotected connections.

1-6 Lucent Technologies 365-314-107R1.1
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Section |: Fault management

Maintenance Overview

Fault management operational mode

Introduction

Service approach

Alarm approach

Changing modes

365-314-107R1.1
Issue 1, July 2002

Two distinct modes of operation are available for the operation of
fault management:

*  Service Approach
*  Alarm Approach

The approach selected determines the forms that fault management
presents to the user, and the filtering and sorting options within these
forms. For more information, refer to “Fault management forms’ (1-8)
in this information product.

The Service Mode of operation focuses on the maintenance of
services provided over the network. Alarms are correlated to an
alarmed object, which in turn enables the services that are affected to
be identified. This allows prioritization to be applied to the
maintenance of the network.

The Service Approach focuses on alarm management from the Traffic
Correlated Alarm List form.

The Alarm Mode of operation focuses on the maintenance of the
network itself. This approach allows the user to look through al of
the alarms on the system, identify where the problems are and what is
causing the alarm.

The Alarm Approach focuses on management of alarms from the
Alarm List form.

The default operational mode for al usersis set on installation. After
installation, the mode can be set on a per user basis, by setting the
Fault Management Operational Mode option on the Preferences form.
The setting selected affects the next and subsequent user sessions. For
more information refer to “ Change the fault management operational

mode” (2-4).

O]
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Maintenance Overview

Fault management forms

Overview

GUI forms

This section describes the supported fault management forms.

The following forms are a functional part of fault management:

Network Event Summary - Alarm View. This form displays al of
the alarms on the system. The form is used to view alarm
summary information when the Alarm Approach is selected.

Network Event Summary - Service View. This form focuses on
the maintenance of services provided over the network. Alarms
are correlated to a trail, circuit, or equipment, which allows
identification of the services that are affected. The form is used
to view correlated alarm summary information when the Service
Approach is selected.

Traffic Corrdlated Alarm List. This form indicates alarms that
affect trails. These are alarms which have been correlated to an
object, because they affect traffic.

Alarm Ligt. This form displays a list of all Navis™ Optical PM -
NP, EMS and network element alarms.

Affected Trail List. This form allows the user to view a list of
trails associated with a selected alarm or alarmed object.

Trouble Ticket forms. These forms allow a user to create or
delete a Trouble Ticket, add alarms to a trouble ticket, and assign
an owner to be responsible for resolution of the problem.

Alarm Log - Service View. This form allows users to view
details about all alarmed objects that are historic, and to archive
and export this information.

Network Navigator Failed Link List. This form allows the user to
display Optical Network Navigator ports with a status of “failed”
and “unknown”.

Alarm Log - Alarm View. This form allows users to view details
about all alarms, and to archive and export this information.

Log Administration - Service View. This form allows the user to
perform archive, export and delete functions for records from the
Alarm Log - Service View.

Log Administration - Alarm View. This form allows the user to
perform archive, export and delete functions for records from the
Alarm Log - Alarm View.

Lucent Technologies 365-314-107R1.1
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Maintenance Overview

Accessing fault management information from the Network Map

Overview

Regenerator alarms

Nodes

Links

The user can access and display fault management forms from the
Network Map.

By selecting the regenerator symbol on a digital link, the user displays
alist of the regenerators on that link. This list indicates which
regenerator has alarms. By selecting a regenerator, the user then cuts
through to the Navis™ Optical PM - NP Alarm List for that network
element.

The user selects a node on the Network Map to cut through to the
SNMS Alarm List for the corresponding network element. The Alarm
List is filtered to show only records which have the network element
ID of the selected node. It is not possible to cut through from an
aggregate node.

By selecting a link on the Network Map, the user accesses a filtered
view of the Traffic Correlated Alarm List for that link. The link must
be between two network elements, and not between two aggregates
and not between a network element and an aggregate. The Traffic
Correlated Alarm List is filtered to show only those trail alarmed
objects that are connections represented by that link.

365-314-107R1.1
Issue 1, July 2002
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Section |: Fault management

Maintenance Overview

Color-coded alarm notification on Network Map

Overview

Links

Nodes

The icons on the Network Map are color-coded to show the alarm
status of the node or link they represent. The link color, the node
color, or the port color is dynamically updated to indicate the current
status of the network.

Nodes and node borders are color-coded to represent the most severe
alarm condition of all alarms reported against that node.

Links are color-coded to represent the service state of that link.

A color-coding scheme for alarms is also used on the fault
management forms.

The link on the Network Map indicates one or more physica
connections between two nodes.

The digital link color on the Network Map is dynamically updated.

The link color displayed is based on the worst case existing on the
link.

*  Green: Indicates that al in-effect trails represented by the link
have no aarms.

* Yelow: Non-Service Affecting. Indicates that at |east one
channelized facility, without provisioned circuits, is aarmed. Also
indicates line degradation alarm, specifically for a digital link
that isin alarm.

Also applies to a channel with a provisioned protected circuit
which has lost its protection path.
A non-assignable circuit does not exist using this digital link.

* Red: Service Affecting. Indicates that at least one
non-channelized facility is alarmed or that at least one
channelized facility with provisioned circuits is alarmed.

*  Blue Identifies the working or unprotected section of atrail (for
Display Route). This color does not indicate whether a fault is
present.

*  Purple: Identifies the protected section of atrail (for Display
Route). This color does not indicate whether a fault is present.

The node color on the Network Map is dynamically updated.

Lucent Technologies 365-314-107R1.1
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Section I: Fault management Maintenance Overview
Color-coded alarm notification on Network

Map
EMS nodes

The node representing an EMS (including Navis™ Optical PM - NP)
change color from green to either red or yellow. Changing color to red
or yellow represents platform alarms on that EMS aone, and do not
show any effect on transmission through the network. In most cases,
there is no impact on services.

Navis™ Optical PM - NP uses the following colors for EMS nodes,

listed in descending order of priority.

« Magenta - Loss of communication with the EMS, shown on the
EMS only.

* Red - Critical or mgor darm. These are EMS platform alarms
only, and do not represent alarms on controlled network
elements.

* Yelow - Other alarm severities. These are EMS platform alarms
only, and do not represent alarms on controlled network
elements.

 Green - No aarm.

Navis™ Optical PM - NP uses the following colors for Navis™ Optical
PM - NP platform alarms.

* Red - Critical or mgjor alarm.

* Yelow - Other alarm severities.

Green - No alarm.

DXC and regenerators

Important! When a node is first added into the Navis™ Optical PM -
NP, it is always displayed as green, independent of whether equipment
or environment alarms exist. Always perform a manual database
synchronization after adding a node to display the true state of the
new node.

Node colors are based on the worst case existing on the node.

«  Green: The communication link between Navis™ Optical PM -
NP and the node is UP. Equipment alarms do not exist.

*  Gray: The node has been deleted, but digital links and circuits
are gtill present. The node cannot be used in further provisioning.

«  Magenta: The communication link between Navis™ Optical PM -
NP and node is down.

365-314-107R1.1 Lucent Technologies 1-11
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Section I: Fault management Maintenance Overview
Color-coded alarm notification on Network

Map

* Red: One or more service affecting equipment alarm condition(s)
are on the network element.

* Yelow: One or more non-service affecting equipment or
environment alarms are on the network element. Service affecting
equipment alarms do not exist on the network element.

Network elements (except regenerators)

Navis™ Optical PM - NP uses the following colors for all network

elements (excluding regenerators), listed in descending order of

priority.

e Green: The communication link between the controlling EMS
and the node is up. No equipment alarms exist.

*  Gray: The node has been deleted, but digital links and circuits
are still present. The node cannot be used in further provisioning.

«  Magenta: The communication link between Navis™ Optical PM -
NP and the node is down.

* Red: One or more major (service-affecting) equipment alarm
condition(s) are on the network element.

* Ydlow: One or more minor (non-service-affecting) equipment or
environment alarms are on the network element. Service-affecting
equipment alarms do not exist on the network element.

»  Orange colored box around the node: One or more uncorrelated
alarms are on the network element.

Black boxes

Black boxes are always green since communication links are not

connected to them from the Navis™ Optical PM - NP, Navis™ Optical

EMS.

Aggregates

Color is based on the worst alarm condition of the nodes, links, or

regenerators associated with this aggregate. The severity of the alarm

condition is from highest to lowest the following:

. Magenta

* Red

* Ydlow

 Green

O
1-12 Lucent Technologies 365-314-107R1.1
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Section |: Fault management

Maintenance Overview

Color-coded alarm notification on fault management forms

Visual alarm display in
user interface forms

365-314-107R1.1
Issue 1, July 2002

In addition to the dynamic node and link color changes caused by
alarms in the Network Map, Navis™ Optical PM - NP provides static
visual display of alarms by using color schemes and/or lists in the
following user interface forms:

e  Graphical Layout

*  Network Event Summary

o  Traffic Correlated Alarm List
o  Affected Trail List
 Alam List

Graphical Layout form

The port in the alarmed trail shown in the graphical layout will show
the alarm as cleared for the correlated port. The Graphical Layout
form display shows the alarm on the port. If a PDH alarm is received
in Navis™ Optical PM - NP, the VC-12 graphical layout shows the
alarm on the 2-Mb/s port. The alarm colors are:

* Red: indicates that an alarm condition exists
e  Green: indicates that alarm condition is not present.

The colors in the graphical layout form are not updated dynamically.
Network Event Summary form

The severity values displayed on the Network Event Summary form
are colored as follows:

e  Critica - red

« Mgor - red

Minor - yellow

e« Warning - yellow

* Indeterminate - yellow.

Traffic Correlated Alarm List form

The fault state values displayed on the Traffic Correlated Alarm List
form are as follows:

 Faled-red
 Degraded - yellow
*  Working - green.

Lucent Technologies 1-13
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Color-coded alarm notification on fault
management forms

The service impact values displayed on the Traffic Correlated Alarm
List are as follows:

 Faled - red

Degraded - yellow

*  Working - green

*  No services - green

e Cdculating - green.

Affected Trail List form

The fault state values displayed on the Affected Trail List form are as
follows:

 Faled - red

 Degraded - yellow

*  Working - green.

Alarm List form

The severity values displayed on the Alarm List form are as follows:
e Criticd - red

* Mgor - red

*  Minor - yellow

Warning - yellow

* Indeterminate - yellow.

1-14 Lucent Technologies 365-314-107R1.1
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User settings

Introduction

Customize form display

Preferences

365-314-107R1.1
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Maintenance Overview

The user setting feature is designed to allow the user to set up
individual user settings in order to organize and customize some of
the fault management forms, which enables the user to display data in
away that is tailored to their needs.

The User Settings feature allows the user to organize and display data
in the following ways:

e  Customize the form display on certain forms
»  Change user preferences, including Operational Mode

The user is able to determine how many columns are visible and in
which order. Additionally, the user can alter the width of each column.

The user can save and retrieve the user-defined form settings, and also
display default forms at any time.

This feature is available to any form with five or more columns.

At instalation, options that relate to fault management are set. The
user can change the following options for their individual login ID:

*  Event Indications

 Map display

* Alarm Color of Forms

*  Fault Management Operational Mode

These options can be changed through the Preferences form, which is
accessed by selecting the following from the Network Map:

Administration > Preferences
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|nstallation options

Introduction

FM operational mode

Interval time

Number of events

Alarm storage limits

Alarm deletion options

Aging period for
restoration notification

Maintenance Overview

Severa installation options that relate to fault management should be
considered when Navis™ Optical PM - NP is installed. They are:

*  FM operational mode

* Interval time

*  Number of events

* Alarm storage limits

*  Alarm deletion options

*  Read-only viewing for GD users

* Aging period for restoration notification
*  Port diasing

Navis" Optical PM - NP is set to run in the default Service Mode or
Alarm Mode. This setting can later be changed by the user for
individual login IDs.

The default interval time for polling to update the counters on the
Network Event Summary forms varies between 30 and 60 seconds.

The default number of events displayed on the Network Event
Summary forms.

The default alarm record limit for current alarms and historic alarms.

The following are options for the deletion of persistent alarms.
Persistent alarms are those which have a raise and a clear.

 Déeete automatically for both unacknowledged and acknowledged
alarms on receipt of a clear.

* Delete automatically for acknowledged alarm on clear.
* Delete automatically for unacknowledged alarms on clear.
* Delete automatically with enforced clear acknowledgement.

The user can set the time, in seconds, that a service trail must be
failed before the restoration component is notified about the failure.

Lucent Technologies 365-314-107R1.1
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Port Aliasing

Maintenance Overview

If enabled, the user can toggle between the Lucent Technologies port
name and their own customer port name on the following screens:

* Network Event Summary - (Events List section) Alarm and
Service view

e Alarm List

e  Traffic Correlated Alarm List

o  Affected Trail List

e Alarm List - Alarm and Service view

365-314-107R1.1
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Optical Network Navigator

Overview

Definition

Navis™ Optical PM - NP
and Optical Network
Navigator interaction

Fault management

Fault state

This section discusses the Optical Network Navigator (ONN).

The ONN is software and hardware present in the LambdaRouter
network elements which performs management functions, i.e.
configuration management and fault management, on optical
connections across a network of LambdaRouters.

The Optical Network Navigator system essentially acts as the network
manager for the domain of optical connections it controls. The Navis™
Optical PM - NP domain provides capacity to the Optical Network
Navigator domain, which provides capacity back to the Navis™
Optical PM - NP. Each management system tracks the fault state of
it’s connectivity, then uses Navis™ Optical PM - NP to display
combined fault state information to the user.

For the current release of Navis™ Optical PM - NP, the Optical
Network Navigator feature is available only on a limited basis.

Fault management performs the following for Optical Network
Navigator:

* Identification of connections which are currently failed. Fault
management identifies which mesh Optical Network Navigator
connections cannot be re-routed and have therefore failed, and
which 1+1 or unprotected connections are failed.

* ldentification of infrastructure (fiber/ducts) which need repair.
Fault management identifies the root cause failure in the network
to allow them to be repaired.

Fault management uses a combination of information to find the fault
state of the connection.

Lucent Technologies 365-314-107R1.1
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Optical Network Navigator

Alarm synchronization

Maintenance Overview

The following are points to note:

Optical Network Navigator mesh connections do not have a
defined route. For these connections, Navis™ Optical PM - NP
considers that the Optical Network Navigator is responsible for
management of the connections and will inform fault
management of the fault state. Fault management will not attempt
to propagate server alarms to these connections and will not
know the route these connection take in the network.

Optical Network Navigator 1+1 protected connections are
identified as “working” or “failed” by Optical Network
Navigator. Fault management will use it’s normal protected
mechanism to mark the connection as degraded.

Optical Network Navigator does not store autonomous notifications
which it sends northbound. As a result, if Navis™ Optical PM - NP or
Optical Network Navigator, or the links between them go down, the
autonomous notifications are lost. Therefore Navis™ Optical PM - NP
does not support alarm re-synchronization for Optical Network
Navigator.

365-314-107R1.1
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Section |I: Performance monitoring

Overview
Purpose Performance monitoring allows the system administrator to precisely
monitor the quality of the end-to-end paths, be notified of
performance degradation, and initiate corrective action, if necessary.
This section describes the Navis™ Optical PM - NP performance
monitoring system.
Contents
Performance monitoring overview 1-21
Performance monitoring data 1-23
Performance monitoring user interface 1-25
PM Port List 1-27
Performance monitoring path list 1-29
Default filter thresholds on the PM Data Reporting 1-30
form
]
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Performance monitoring overview

Purpose

Benefits

Effects of rearrange and
merge on performance

monitoring

The purpose of Navis™ Optical PM - NP performance monitoring is to
enable the user to:

»  Define the paths (via ports) in the network to monitor for
performance monitoring

e  Start or stop the collection of performance monitoring data for
the paths

*  Set parameter thresholds for Threshold Crossing Alert (TCA)
reporting

* Request display of data with filtering capabilities by path, date
range, and threshold

The “dacscan” login has to be present on the workstation from where
performance monitoring reports are requested. See Navis™ Optical
PM - NP Administration Tasks for details on adding the “dacscan”
login.

Performance monitoring facilitates the planning and implementation of
proactive, forward-looking network maintenance strategies by
providing a centralized facility to monitor network performance
systemically. This is accomplished by non-intrusively gathering
in-service information about the state of the network. The gathered
information can be effectively used to maintain existing uninterrupted
delivery of services.

Because a digital link or facility/circuit requires two nodes, two ports
are always associated with a path. However, performance monitoring
data may not be collectible from both ports.

When circuits with existing monitoring points are to be merged and if
the total number of monitoring points for the merged circuit does not
exceed four, performance monitoring points as they exist prior to the
merging are retained. However, if the number of monitoring points
exceed four after merging, the Navis™ Optical PM - NP displays a
notification that includes the number of ports where performance
monitoring collection has to be stopped for the merge to succeed.

Performance monitoring data collection will not be stopped if a circuit
is rearranged, as long as the ports where performance monitoring data
collection is occurring are part of the new (rearranged) path. If

365-314-107R1.1
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performance monitoring data collection occurs on ports that are no
longer part of the new path, performance monitoring on these ports is
stopped and deleted. The performance monitoring stopping and
deletion are done automatically as part of the rearrange process.
performance monitoring cannot be reinstated if a rearrange fails after
performance monitoring has been stopped to support the rearrange
process. It is the user’s responsibility to restart performance
monitoring on those ports.

Supported network  Navis" Optical PM - NP supports performance monitoring for the
elements  following network elements:

«  Lambda UNITE™ MultiService Switch Release 2.0

*  Metropolis® EON Release 8.0 and 8.1

*  Metropolis® DMXpress Release 1.0

*  Metropolis® DM Xpress Access Multiplexer Release 2.0 and 2.1
*  WaveStar® BandWidth Manager Release 4.1

*  WaveStar® OLS1.6T Release 6.1

*  WaveStar® TDM 2.5G/10G Release 6.0
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Performance monitoring data

Overview

Performance monitoring

data

Types of performance
monitoring data

Time periods

The performance of a transport connection is monitored by an EMS at
termination points located at its extremities, or at termination points
located along its route. This monitoring can occur as long as the
network elements at these termination points each have the capability
to monitor performance parameters.

In the case of the SONET network, performance parameters are
determined from anomalies and defects detected at termination points.

The following are examples of performance parameters:

* erored seconds (ESs)

* severely errored seconds (SESs)

»  background block errors (BBES)

* unavailable seconds (UAS)

Those network elements with the capability to count the number of
these performance parameters detected over a specific period of time,
transfer the values of its counters to the EMS. Navis™ Optical PM -
NP collects the counter data from selected termination points through

services provided by the EMSs. The counter values are know
collectively as performance monitoring data.

In the case of certain network elements, the performance monitoring
data available at a termination point represents errors detected in the
signal received at the termination point. This is known as near-end
data.

For other network elements, the performance monitoring data
represents both near-end and far-end data. Far end data represents
error measurements taken at the upstream extremity of the transport
connection, of which the termination point is part.

All network elements managed by Navis™ Optical PM - NP use two
time periods to accumulate unidirectional performance parameters.

They are:
. 15 minutes
. 24 hours

365-314-107R1.1
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Performance monitoring data

PM Data Export/file
transfer

Navis™ Optical PM - NP automatically requests each EMS to recover
all performance monitoring data collected during the previous 24
hours, from midnight to midnight. Navis™ Optical PM - NP stores the
recovered 24-hour data on a single designated UNIX workstation. One
week of data is stored.

For Navis™ Optical EMS managed network elements, the file format
used for the file transfer is per the TMF G72.0 interface definition.
O
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Performance monitoring user interface

Introduction

Performance menu

Message log

The performance monitoring feature is accessible from Performance
menu on the Network Map and from the Graphical Layout form.

The performance monitoring feature is accessible from the Network
Map and from the Graphical Layout form.

From the Performance menu on the Network Map, the following

Maintenance Overview

performance monitoring capabilities can be accessed:

PM Path List: Allows the user to perform performance
monitoring on monitored paths.

PM Port List: Allows the user to perform performance
monitoring data collection.

Subfunctions

The following are subfunctions that allow the user to access
performance monitoring capabilities.

Ckt/DTS: dlows the user to enter the circuit ID or order number
for a port or trail to be monitored. The minimum entry is the
Order number.

Data Collection: allows the user to start, stop, or schedule
collection of performance monitoring data from the network for
the path.

Threshold Setting: allows the user to set thresholds on the
monitored ports of the path that the network elements use to
report TCAS.

Path List Query: (Optional) allows the user to enter the
CKT/Trail 1D, Location, circuit type, and from/to date to display
and modify the monitored trail/port. Selecting OK displays all
monitored trails in the path list.

Port List:displays a list of monitorable ports.

Data Reporting:allows the user to view performance monitoring
data that was collected from the network for the path.

The DXC Administration Node Menu provides the following form:

Performance Monitoring Message Log: contains DXC
performance monitoring output messages.

365-314-107R1.1
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Threshold crossing alerts  The Alarm List displays:

*  Threshold Crossing Alerts: allows the user to be aerted of
threshold levels that crossed the set thresholds.
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PM Port List

Overview

Select termination points
for data collection

About data collection

365-314-107R1.1
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The PM Port List form allows the user to perform the following
functions related to the collection of performance monitoring data.

» displaying al monitorable ports for a path

» selecting terminations points for data collection
e start and stop data selection

»  schedule data collection

*  delete performance monitoring

The PM Port List provides the user with a means to identify a single
trail for which performance monitoring data is to be collected. The
user may collect performance monitoring data from in-effect transport
connections only.

The user selects up to four ports to be monitored, and selects whether
15-minute or 24-hour performance monitoring data is collected. In the
case of WaveStar® DACS, the user select one hour performance
monitoring data.

Performance monitoring data collection allows the user to start
performance monitoring for a trail that has not yet been set up (on the
Navis™ Optical PM - NP) or to add more ports to be monitored on the
trail. performance monitoring data collection also alows the user to
modify the monitored trail/port in terms of trail type

(network-el ement-dependent), start/stop time, location/port, and
measurement period.

When performance monitoring is requested by the user, default ports
that would result in Trail Termination Point (TTP) monitoring points
are identified by the Navis™ Optical PM - NP and their port addresses
are automatically populated on the PM Port List form for a particular
path. If the user accepts these two default trail termination ports and
does not add any more ports and proceeds, the procedure amounts to
a TTP performance monitoring. When the user navigates from the
Graphical Layout, the A and Z location/Ports are pre-populated but the
intermediate monitors (if trail has more than two monitors) are not
displayed in the selection list until the user specifies the trail type and
measurement period.
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PM Port List

Start and stop data
collection

When one or both trail termination points are not appropriate for
performance monitoring (for example, the termination points are
outside the managed domain), the Navis™ Optical PM - NP identifies
other monitoring ports. These ports are then used as default ports to
automatically populate the Port List Data form. The user can accept,
modify, or add to these ports. A trail is defined by the CKT/Trail ID,
Circuit Type, Trail Type and Measurement Period.

Important! The user should use caution when entering port data,
as the Navis™ Optical PM - NP system does not check for
duplicate port entries. An error or warning message is not
presented if the user enters the same port data.

Using the PM Port List, the user starts and stops data collections on a
selected port. Additionally, the user may delete a port from the list of
monitored ports, however the user must stop the collection of
performance monitoring data first.

The user may select up to four sets of data per trail, per granularity
associated with the transport connection selection.
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Performance monitoring path list

Overview The PM Path List alows the user to perform performance monitoring
functions on monitored paths.

These functions include;

* view alist of ports for which performance monitoring data is
being monitored

»  Performance monitoring data reporting
e set up and view thresholds

View a list of ports  The PM Path List provides the user with a list of ports for which
performance monitoring data is being monitored.

Monitored ports are depicted as follows:
o  Started: performance monitoring data is currently being collected

e  Stopped: performance monitoring data has been collected and
collection is no longer taking place

*  Scheduled: performance monitoring data is scheduled to be
collected in the future

Data reporting  From the PM Path List, the user accesses the PM Data Reporting
form, which allows the user to request a report of performance
monitoring parameter values for selected ports in either tabular or
graphical format. The user may filter the report by parameter type.

Threshold crossing alerts  From the PM Path List the user access the Threshold Setting form
which alows the user to set each of the TCA parameters for one or
two ports associated with a selected transport connection, on a per
granularity basis.
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Default filter thresholds on the PM Data Reporting form

Overview

Filters

Effect of filters

The following are three independent filters that may be applied to the
tabular or graphical display of performance monitoring data.

. Standard Level 1
. Standard Level 2
. User Defined

The user selects one of these filters, displayed as tabs on the PM Data
Reporting form, as the one filter that applies to the desired display of
performance monitoring data.

The Standard Level 1 and the Standard Level 2 filters are derived
from the ITU-T recommendation M.2101’s “Default Unacceptable
Thresholding” for independent monitoring. The Level 2 filter is set at
the Unacceptable Threshold while the Level 1 filter is derived as 0.5
times the Level 2 filter to provide a useful range. The thresholds
depend only on the measured parameter, 15-minute or 24-hour
granularity, and the rate of the measured circuit/trail or link.

The User Defined filter allows user data entry of a setting that makes
sense for the data at hand. The user-defined threshold entries are all
initialized to “0” at the start of the first user session. Once entered,
these values are available for the current and subsequent user sessions,
but do not persist after a workstation reboot.

When any one of the three filter tab choices (Level 1, Level 2, or
User Defined) are applied to the PM Data Reporting form, the filtered
performance monitoring parameter is displayed with the following
modification:

Displayed Value for X = {Stored value of X | given that
it is above the filter threshold}

No parameter displays when it is at or below its threshold, and no
negative values display. The absence of a parameter (when not greater
than its threshold) displays with a dash.
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Default filter thresholds on the PM Data
Reporting form

Keep in mind  Keep in mind the following when using default filter thresholds.

1. Where the standards do not cover a parameter explicitly, the
network-element-specific guidelines are consulted to fill in the
uncovered thresholds as official Navis™ Optical PM - NP default
values. Some parameters may be left without default values.
Where a parameter is unspecified, the value “0” displays.

2. The feature is installed on the Navis" Optical PM - NP host, as a
performance monitoring Option, with special off-line adjustments:

«  The filter table can be reinitialized anytime the Navis™
Optical PM - NP is off line.

. The filter tables are editable with a UNIX editor.

«  The next initialization of the Navis™ Optical PM - NP GUI
carries the edited filter settings, which persist from session
to session, until the next edit.

3. User Defined setting are available for the current and subsequent
user sessions, but they do not persist after a workstation reboot.

O
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2 Fault management tasks

Overview

Purpose  This chapter describes fault management tasks that can be performed

for Navis™ Optical PM - NP,

Related topics  The following topics are related to fault management.

Database synchronization

Database synchronization is done to manually repopulate the Navis™

Optica PM - NP database with network element and alarm

information from an EMS. For information, refer to Navis™ Optical

PM - NP Administration Guide.

Contents
Acknowledge an alarm

Change the fault management operational mode

Filter secondary alarms

Create a trouble ticket

Add alarms or alarmed objects to trouble tickets

Delete a trouble ticket

Delete an alarm from the Alarm List

Archive, export, and delete alarm log records

Perform a manual alarm synchronization
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View alarms on a link between two network
elements

View alarms on a bridge

View alarms for a network element

View alarms for an EMS

Filter non-alarm events from the Network Event

Summary form

View alarm counts from the Network Event
Summary
Filter/sort alarms

Display Optical Network Navigator ports with
failed and unknown status

Fault management tasks
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Acknowledge an alarm

Purpose Use thistask to acknowledge an alarm. The user can acknowledge
alarms from these forms:

. Traffic Correlated Alarm List
. Alarm List

Before you begin  For more information on acknowledging alarms, refer to Chapter 4,
“Alarm management concepts’ in this information product.

Task  Perform the following steps to acknowledge alarms from the
Traffic Correlated Alarm List and the Alarm List.

1 From either the Traffic Correlated Alarm List or the Alarm List, select
the desired alarm or alarms to be acknowledged.
Result:

The selected alarm(s) is/are highlighted.

2  Select Actions > Acknowledge, or click the Acknowledge button on
the toolbar.

Result:

The selected alarms are acknowledged. Additionally, associated
alarms are automatically acknowledged.

In order to see the changes displayed on the form, select Query
Again.
END OF STEPS
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Change the fault management operational mode

Purpose

Before you begin

Task

The fault management operational mode is set at installation, however,
the user has the option of changing the operational mode for their
individual user ID.

For more information about the fault management operational modes,
refer to Chapter 4, “Alarm management concepts’.

Perform the following steps to change the fault management
operational mode for an individual user login ID.

From the Network Map, access Administration > Preferences.
Result:
The Preferences form displays.
Select the FM Operational Mode tab.
Result:
The FM Operational Mode tab displays.

Select the desired operational mode by clicking the appropriate radio
button.

Result:

A dialog box advises the user that the change will only take
effect for their next and subsequent sessions.

Click OK.
Result:
The user is returned to the Network Map.

The operational mode change will take effect for the user’s next
and subsequent sessions. In order to use the new operational
mode, the user must log off and log on again.

END OF STEPS
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Filter secondary alarms

Purpose If the option to filter secondary alarms is not chosen at the time of
installation, the user may use fault management forms to filter
secondary alarms.

The user may filter secondary alarms from the following forms:
e Alarm List
o  Traffic Correlated Alarm List

Before you begin  For more information about filtering secondary alarms, refer to
Chapter 4, “Alarm management concepts’.

Filter secondary alarms  Perform the following steps to filter secondary alarms from the
from the Alarm List  Alarm List.

1 Access the Alarm List by doing one of the following:
»  From the Network Map select, Fault > Alarm List

. From the Alarm List, select File > New Query, or select the New
Query button.

Result:

The Filter tab of the Filter/Sort for Alarm List form displays.
2  Select Alarm Group from the drop down list.

Result:

A list of alarm groups displays.
3  Sedlect one or more of the filter options.

Important! By selecting all of the alarm groups except Signal
Failed - Secondary, all aarms are filtered into the Alarm List
except the secondary alarms.

4 Click OK.
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Filter secondary alarms

Filter secondary alarms
from the Traffic Correlated
Alarm List

Fault management tasks

Result:

The user is returned to the Alarm List, which displays the
appropriately filtered alarms.

END OF STEPS

Perform the following steps to filter secondary alarms from the
Traffic Correlated Alarm List.

Access the Traffic Correlated Alarm List by doing one of the
following:

*  From the Network Map select, Fault > Traffic Correlated Alarm.

e  From the Traffic Correlated Alarm List, select File > New Query,
or select the New Query button.

Result:

The Filter tab of the Filter/Sort for Traffic Correlated Alarm List
form displays.

Click OK.
Result:

The user is returned to the Traffic Correlated Alarm List, which
displays the appropriately filtered alarms.

END OF STEPS
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Create a trouble ticket

Purpose

Before you begin

Task

Use this task to create a trouble ticket. The user accesses the Trouble
Ticket Details form from either the Traffic Correlated Alarm List or
the Alarm List.

For more information refer to Chapter 4, “Alarm management
concepts” in this information product.

Perform the following steps to create a trouble ticket from either
the Traffic Correlated Alarm List or the Alarm List.

From either the Traffic Correlated Alarm List or the Alarm List, select
the alarm or alarmed objects for which a trouble ticket will be
created.

Important! The user may select multiple alarms or alarmed
objects at once.

Select Actions > Trouble Ticket > Create.
Result:
The Trouble Ticket Details form displays.

In the Trouble Ticket ID field, type the user-defined identifier of the
trouble ticket

Optional: In the Owner field, type the login ID of the user who owns
the trouble ticket.

Optional: In the Remarks field, type in descriptive text associated
with the trouble ticket.
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Result:

The trouble ticket is created, and the user is returned to the
origina form.
END OF STEPS
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Add alarms or alarmed objects to trouble tickets

Purpose

Before you begin

Task

365-314-107R1.1
Issue 1, July 2002

Use this task to add additional alarms or alarmed objects to an
existing trouble ticket. The user accesses the Trouble Ticket Details
form from either the Traffic Correlated Alarm List or the Alarm List.

For more information on trouble tickets, refer to Chapter 4, “Alarm
management concepts’ in this information product.

Perform the following steps to add alarms or alarmed objects to a
trouble ticket.

From the Traffic Correlated Alarm List or the Alarm List, select the
alarm or alarmed object to be added to a trouble ticket.

Important! The user may select multiple alarms or alarmed
objects to be added at once.

Select Actions > Trouble Ticket > Add selected Alarms to Trouble
Ticket.

Result:
The Trouble Ticket Details form displays.

In the Trouble Ticket ID field, type the identifier of the trouble ticket
to which the selected alarms or alarmed objects will be added.

Click OK.

Result:

The selected adlarm or alarm object is added to the trouble ticket,
and user is returned to the origina form.
END OF STEPS
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Delete a trouble ticket

Purpose

Before you begin

Task

Trouble tickets are automatically deleted by Navis™ Optical PM - NP
when al the associated alarms or the associated alarmed objects are
deleted. In addition, the user may manually delete a trouble ticket
from the Trouble Ticket form. In both cases, the user can view the
alarm and trouble ticket information, less the remarks, from the Alarm
Log.

Use this task to manually delete trouble tickets.

For more information on trouble tickets, refer to Chapter 4, “Alarm
management concepts’.

Perform the following steps to delete trouble tickets. To delete
trouble tickets containing alarmed objects, the user should begin
this task from the Traffic Correlated Alarm List form. To delete
trouble tickets containing alarms, the user should begin this task
from the Alarm List form.

Select the alarm or alarmed object containing the trouble ticket to be
deleted.

Sdlect Actions > Trouble Ticket > Delete.
Result:
A confirmation dialog box displays.
Click OK.
Result:

The trouble ticket is deleted and the user is returned to the
origina form.
END OF STEPS
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Delete an alarm from the Alarm List

Purpose Navis" Optical PM - NP automatically deletes instantaneous alarms
based on a deletion option set at the time of installation. Use this task
to manually delete alarms.

Deleted alarms are not removed from the system, but are moved to
the Alarm Log.

Task  Perform the following steps to manually delete alarms.

2 Sdect Actions > Delete.

Result:

A confirmation dialog box displays.
3 Click OK.

Result:

The alarm is deleted and the user is returned to the Alarm List.
END OF STEPS

O
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Archive, export, and delete alarm log records

Purpose

Filtering the alarm or
alarmed object records

Before you begin

Task

Alarm log administration functions (archive, export, and delete) are
performed from the Log Administration form. This form supports both
the service and alarm modes. In service mode, it is used to archive,
export, and delete alarm log records from the Alarmed Object Log. In
both modes of operation, alarm log records in the Alarm Log can be
archived, exported, and filtered.

The user must filter the alarm or alarmed object records to be
archived, exported or deleted. Otherwise, all records will be archived,
exported, or deleted.

For more information on alarm log records, refer to Chapter 4,
“Alarm management concepts’.

Perform the following steps to archive, export, or delete alarm
log records.

From the Network Map, select Fault > Alarm Log Alarm View or
Fault > Alarm Log Service View

Result:

The filter/sort window for the selected form displays.
Select the desired filter criteria and click OK.

Result:

The filtered Alarm Log Alarm View or Alarm Log Service View
form displays.

Select Actions > Log Administration.
Result:

The Log Administration Alarm View or Log Administration
Service View form displays.

Optional: Select File > New Query, and apply additional filtering
criteria to the displayed alarms or alarmed objects.
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Archive, export, and delete alarm log

You want to archive alarm
log records.

You want to export alarm
log records.

You want to delete alarm
log records.

You want to archive alarm
log records.

You want to export alarm
log records.

You want to delete alarm
log records.

Click OK.

Result:

Fault management tasks

THEN

Enter the destination of the archive
alarm log records in the Archive To:
field.

Enter the destination of the export
alarm log records in the Export To:
field.

Important! Always enter the complete
path, for example:
/usr/dacscan/my_export.

Enter the destination of the delete
alarm log records in the Archive To:
field.

THEN
Select Actions > Archive.

Result: A confirmation dialog box
displays.

Select Actions > Export.

Result: A confirmation dialog box
displays.

Select Actions > Delete.

Result: A confirmation dialog box
displays.

The selected alarm log records are archived, exported, or
deleted, and the user is returned to the Log Administration form.

END OF STEPS

OJ
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Perform a manual alarm synchronization

Purpose

Before you begin

Task

Navis™ Optical PM - NP provides automatic alarm synchronization in
many instances. A manua alarm synchronization may also be initiated
by the user. Use this task to perform an manual aarm
synchronization.

For more information on alarm synchronization, refer to Chapter 4,
“Alarm management concepts”.

Perform the following steps to execute a manual alarm
synchronization.

Access the Network Controller Map by executing File -> Network
Controller Map.

Result:
The Network Controller Map is displayed.

On the map, right-click the EM S node with which the manual
database synchronization should be performed.

Result:
A Node menu appears.
Select Sessions -> Start EMS Synchronization.
Result:
The Database Synchronization form is displayed.

On the Database Download/Synchronization form, ensure that
Alarm is selected in the Type drop down list.

Select Alarm.
Result:

An alarm synchronization occurs with all the network elements
under control of this EMS.
END OF STEPS
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Fault management tasks

View alarms on a link between two network elements

Purpose

Definition: link

Task

365-314-107R1.1
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Use this task to view alarms on a link between two network elements.

A link is an icon on the Network Map that represents all of the
connections between two network elements. A link appears as a thin
line between network elements on the Network Map.

Perform the following steps to view alarms on a link.

From the Network Map, right-click on a link.

Important! The link must be between two network elements.
This task cannot be performed for links between the following:

* network elements and aggregates

e aggregates and aggregates
Result:
The Link menu displays.

Select Traffic Correlated Alarm List.
Result:

The Traffic Correlated Alarm List form displays, filtered to
show alarmed objects on the link.

Select Actions > Alarm List.
Result:

The Alarm List form displayed, filtered to show alarms on the
link.

END OF STEPS
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Fault management tasks

View alarms on a bridge

Purpose Use this task to view alarms on a bridge.

Definition: bridge A bridge is an icon on the Network Map that represents all of the
connections between two areas. A bridge appears as a heavy line
between areas on the Network Map.

TASK  ceereereeree e E e bRtk h Rt bR R R e e ettt e et e et
1 From the Network Map, right-click on a bridge.
Result:
The Link List form displays.
2  Select Actions > Traffic Correlated Alarm List.

Result:

The Traffic Correlated Alarm List form displays, filtered to
show the alarmed objects on the bridge.
END OF STEPS
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Fault management tasks

View alarms for a network element

Purpose

Task

365-314-107R1.1
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Use this task to view alarms for a network element.

Perform the following steps to view alarms for a network
element.

On the Network Map, right-click on a network element.
Result:

The Node menu displays.

Select Alarm List.

Result:
The Alarm List displays alarms filtered for the selected network
element.
END OF STEPS
O
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View alarms for an EMS

Purpose

Task

On the Network Controller Map, nodes representing EMSs, (including
Navis™ Optical PM - NP), change color to indicated the alarm
condition of the EMS. When a node is either red or yellow, EMS
platform alarms are present on the EMS.

Use this task to determine what has caused a red or yellow alarm
condition on EMS nodes on the Network Controller Map.

From the Network Controller Map, note the name of the EMS that is
either red or yellow.

Close the Network Controller Map.

Result:

The Network Controller Map closes, and the Network Map
displays.

From the Network Map, select Fault > Alarm List.
Result:

The Filter/Sort for Alarm List form opens.

Result:

The Alarm List opens filtered for the alarms on the specific
EMS. This list allows the user to determine the cause of the red
or yellow alarm condition of the EMS on the Network
Controller Map.

END OF STEPS
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Fault management tasks

Filter non-alarm events from the Network Event Summary form

Purpose

Non-Alarm Events

Task

365-314-107R1.1
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The Network Event Summary form provides automatic filters with
which to view alarms. Alarms can be filtered by categories of
non-alarm events.

Alarms can be filtered into five categories by selecting one of the
following buttons in the Non-Alarm Events section of the Network
Event Summary form:

* Restoration - opens a list of new successful restoration circuit
orders. Thisis only available if the restoration feature is used.

* Restoration Failed - opens a list of new failed restoration circuit
orders. This is only available if the restoration feature is used.

*  Network Discrepancy - opens a list of the Optical Network
Navigator managed cross connections which are not part of a
connection in Navis™ Optical PM - NP.

Perform the following steps to view filtered non-alarm events
from the Network Event Summary form.

From the Network Map, select Fault > Network Event Summary.
You may select either the service view or the alarm view.

Result:
The Network Event Summary form opens.

In the Non-Alarm Events section of the form, select a button under
one of the five displayed categories.

Result:

The selected list of filtered non-alarm events displays.

END OF STEPS
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Fault management tasks

View alarm counts from the Network Event Summary

Introduction

Alarm Counts - alarm view

Alarm Counts - service

view

Task

Alarm counts can be viewed on the Network Event Summary form.

Different categories are displayed for the alarm view and the service
view.

In the Alarm View, the user selects a button in the Alarm Counts
section of the Network Event Summary to display a filtered Alarm
List, categorized by alarm status.

By expanding the Traffic Correlated Object Counts section on the
Network Event Summary - Service View, the user displays columns of
buttons which categorize alarms as follows:

o darm status and service
* darm status and layer
Selecting buttons in these areas opens either a filtered Traffic

Correlated Alarm List for correlated alarms or a filtered Alarm List
for uncorrelated alarms.

Perform the following steps to view alarm counts from the
Network Event Summary form.

From the Network Map, select Fault > Network Event Summary.
Result:

The Network Event Summary form opens.

To expand/contract either the Traffic Correlated Object Counts, or
Uncorrelated Alarm Counts section, select the up-arrow or
down-arrow key, located next to the Totals row in either section.

Result:

The appropriate section expands/contracts. Categories of alarms
and/or alarmed object counts display in columns of Total
Raised, Unack’d Raised, and Unack’d Clear.

END OF STEPS
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Filter/sort alarms

Purpose

Accessing filter/sort

Before you begin

Task

Fault management tasks

Most of the fault management forms allow the user to filter and/or
sort the information that displays on the form. Use this task to filter
and/or sort the information displayed on fault management forms.

The user can access the sort/filter window of fault management forms
in the following ways:

*  When accessing a fault management form from the Network Map
main menu, the user is presented with the Filter/Sort window for
that particular form.

*  Once the user accesses a fault management form, new filter/sort
criteria can be applied by either clicking the New Query button,
or selecting File > New Query.

The user may erase previously applied filter/sort criteria by selecting
the Clear button from the Filter/Sort window.

For more information refer to Chapter 4, “Alarm management
concepts” in this information product.

Perform the following steps to filter and sort information
displayed on fault management forms.

Access the Filter/Sort window of the desired fault management form.
For more information, refer to “Accessing filter/sort” (2-21).

Result:

The Filter/Sort window displays.

To select additional filter/sort criteria, click the More button.
Result:

Additional filter or sort drop-down menus display from which
additional criteria can be selected.
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Filter/sort alarms Fault management tasks

6 Click OK.
Result:

The original form displays with the specified filter/sort applied.

END OF STEPS

O
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Fault management tasks

Display Optical Network Navigator ports with failed and

unknown status

Purpose

Before you begin

Task

365-314-107R1.1
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Use this procedure to display a list of Optical Network Navigator
alarmed ports with a status of “failed” or “unknown”.

For more information refer to Chapter 4, “Alarm management
concepts” in this information product.

From the Network Map, select Fault > ONN Failed Link List.
Result:
The Filter/Sort of Network Navigator Failed Link List opens.
Select the appropriate sort/filter criteria and then select OK.
Result:

The Network Navigator Failed Link List opens, displaying a list
of Optical Network Navigator alarmed ports with a status of
“failed” or “unknown”.

END OF STEPS
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3 Performance monitoring tasks

Overview
Purpose  This chapter describes performance monitoring tasks that can be
performed for Navis™ Optical PM - NP.
Contents
Performance monitoring tasks 3-2
Display the installed date format 3-3
Set up a monitoring point 3-4
Set a threshold value for a performance parameter 3-6
Create a data report 3-8
Delete a monitoring point 3-11
Execute the performance monitoring export tool 3-12
Change the scheduled run time of the performance 3-13
monitoring file transfer
Add special archiving features for performance 3-14
monitoring
]
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Performance monitoring tasks

Performance monitoring tasks

Overview
Purpose  This chapter describes performance monitoring tasks that can be
performed for Navis™ Optical PM - NP.
Contents
Display the installed date format 3-3
Set up a monitoring point 3-4
Set a threshold value for a performance parameter 3-6
Create a data report 3-8
Delete a monitoring point 3-11
Execute the performance monitoring export tool 3-12
Change the scheduled run time of the performance 3-13
monitoring file transfer
Add special archiving features for performance 3-14
monitoring
O
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Performance monitoring tasks

Performance monitoring tasks

Display the installed date format

Purpose

Specifying single-digit
months or days

Task

365-314-107R1.1
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Use this procedure to display the installed date format. The date
format is set at installation. You must adhere to the installed date
format when entering any dates into the system. The date format can
be set to be either of the following:

« American (MM-DD-YYYY)

»  European (DD-MM-YYYY), or YYYY-MM-DD, where
DD=01-31, MM=01-12 and YYY'Y=1970-2037.

For either format, single-digit months or days can be represented
using one digit or two. For example, "01” or “1” can be used to
specify the month of January.

Perform the following steps to display the installed date format.

Select Date Format.

Result:
The installed date format is displayed.

END OF STEPS
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Performance monitoring tasks

Set up a monitoring point

Purpose

Related information

Task

Use this procedure to set up a new monitoring point. Monitoring
points are used to identify points in the network that can be used to
monitor performance.

For more information on performance monitoring, see Chapter 6,
“Performance monitoring parameters’ in this information product.

Complete the following task to set up a monitoring point.

From the Network Map, select Performance > PM Port List >
Display/Modify

Result:
The PM Port List Query box displays.

From the Measure Period drop-down menu, select the measure
period.

Click the OK button.
Result:
The PM Port list displays.

This function must be performed at the EMS level. In the Schedule
Start Collection area, select a starting period.
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Performance monitoring tasks Performance monitoring tasks
Set up a monitoring point

IF THEN
You want collection to start | Select the Start > Now check box.
immediately.
You do not want collection ' ynger Actions select a starting period
to start immediately. as follows:
* |In the Date field, enter the start
date.
* In the Time field, enter the start
time.

8  This function must be performed at the EMS level. In the Schedule
Stop Collection area, select a stopping period. The default is to
continue collecting indefinitely or until a user, at some later time,
stops the collection.

IF THEN

You want collection to stop | Select the Stop > Now check box.
immediately.

If you do not want Under Actions, select a stopping
collection to stop period as follows:

immediately.

* In the Date field, enter the stop
date.

» (Optional) Enter the stop time in
the Time field.

Result:

The monitoring point is set, and the PM Port List form closes.
END OF STEPS

O
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Performance monitoring tasks

Performance monitoring tasks

Set a threshold value for a performance parameter

Purpose

Related information

Task

Use this procedure to set or change the threshold levels for parameters
on a network element that supports threshold setting and reporting.

For more information on threshold setting for performance parameters,
see Chapter 6, “Performance monitoring parameters’.

Complete the following task to set or change the threshold levels
for parameters on a network element that supports threshold
setting and reporting.

From the Network Map, select Performance > PM Path List>
Display/Modify.

Result:
The PM Path List Query Box displays.

Enter the appropriate information in the Circuit ID, Location, Data
Collection From Date, and Data Collection To Date fields.

Click OK.
Result:
The PM Path List displays.

In the Trail Type-Measurement scrolling lists, select the trail type
and measurement periods.

Enter a threshold value for a particular parameter, and the port (either
1, 2 or 1 or 2) supporting that parameter.

For valid ranges, see the network element user manuals.
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Performance monitoring tasks Performance monitoring tasks
Set a threshold value for a performance
parameter

8 Click Apply.
Result:

Commands are sent to the appropriate network elements to set
the new thresholds.

END OF STEPS
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Performance monitoring tasks

Create a data report

Purpose

Related information

Task

Performance monitoring tasks

Use this procedure to generate a report that contains performance
monitoring data collected from the network. Data can be accessed on
a port basis. The report can be displayed on the screen or can be sent
to a printer.

For related information, see Chapter 6, “Performance monitoring
parameters’.

Complete the following task to generate a report that contains
performance monitoring data collected from the network.

From the Network Map, select Performance > PM Path List >
Display/Modify.

Result:

The PM Path List Query Box containing Circuit ID, Location,
and Data Collection displays.

Enter information in the Circuit ID, Location, and Data Collection
fields.

Click the OK button.

Result:
The PM Path List displays.

Select Actions > Data Reporting.
Result:

The PM Data Report Query box displays.
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Performance monitoring tasks
Create a data report

10

11

12

13

14
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Performance monitoring tasks

Accept the port/locations, or select the port from the list of available
ports.

Enter the Start Date/Time for the time interval on which you wish to
see a report.

Enter the Stop Date/Time for the time interval on which you wish to
See a report.

Result:

If Navis™ Optical PM - NP was not able to collect data during
the scheduled time interval (either the network element was not
available, or the time interval exceeds that of the scheduled
Start/Stop date and time), then the periods that were not
collected will be reported as NA (Not Available).

Select the parameters you wish to view on the report from the list.
Select as many as you wish to display.

Select Threshold Levels.

The ITU standard filters are as follows;

* Leve 2 contains the threshold values as per specified ITU
standards.

 Leve 1ishaf the Level 2 threshold values.
e  User-defined values are determined by the user.

If you wish to print the report, select File > Print.
Result:

The Printer Selection form displays.
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Performance monitoring tasks Performance monitoring tasks
Create a data report

15  Select a printer.

Result:

The report is sent to the printer.
16  Click Apply .

Result:

The collected data displays in the specified report format.

END OF STEPS
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Performance monitoring tasks

Delete a monitoring point

Purpose

Related information

Task

365-314-107R1.1
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Use this procedure to delete a monitoring point.

For more information on performance monitoring, see Chapter 6,
“Performance monitoring parameters’ in this information product.

Complete the following task to delete a monitoring point.

From the Network Map, select Performance > PM Path List >
Display/Modify.

Result:
The PM Path List Query Box displays.

Click OK .
Result:
The PM Path List displays.

Select Actions > Delete.

Result:

A confirmation window displays.
Click Yes .

Result:

The monitoring point is deleted.

END OF STEPS
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Execute the performance monitoring export tool

Performance monitoring  The following performance monitoring tasks are performed by the
administration  System Administrator.

*  Execute the performance monitoring export tool

*  Change the scheduled run time of the performance monitoring
file transfer

*  Add specia archiving features for performance monitoring
For further information

For further information on performance monitoring administration
tasks see Navis™ Optical PM - NP Administration Guide
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Performance monitoring tasks Performance monitoring tasks

Change the scheduled run time of the performance monitoring
file transfer

Performance monitoring  The following performance monitoring tasks are performed by the
administration  System Administrator.

*  Execute the performance monitoring export tool

e  Change the scheduled run time of the performance monitoring
file transfer

*  Add special archiving features for performance monitoring
For further information

For further information on performance monitoring administration
tasks see Navis™ Optical PM - NP Administration Guide
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Performance monitoring tasks Performance monitoring tasks

Add special archiving features for performance monitoring

Performance monitoring  The following performance monitoring tasks are performed by the
administration  System Administrator.

*  Execute the performance monitoring export tool

*  Change the scheduled run time of the performance monitoring
file transfer

*  Add specia archiving features for performance monitoring
For further information

For further information on performance monitoring administration
tasks see Navis™ Optical PM - NP Administration Guide
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4 Alarm management concepts

Overview
Purpose  This chapter describes fault management concepts for Navis™ Optical
PM - NP.
Contents
Alarm collection 4-2
Alarm classification 4-4
Alarm correlation 4-8
Fault state determination 4-13
Alarm and alarmed object suppression 4-20
Service impact assessment 4-22
Alarm deletion 4-24
Alarm acknowledgement 4-25
Domain partitioning 4-27
Trouble ticketing 4-28
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Alarm collection

Introduction

Alarms received from the
network

Alarm management concepts

Navis™ Optical PM - NP is notified for each EMS it manages about
all of the following:

*  Network element alarm raise and clear events reported to the
EMS

*  Network element loss of associated events

 EMS platform management alarms

Al TCA (threshold crossing alert) events

* All Optical Network Navigator alarm raise and clear events

* All Optical Network Navigator management alarms, including
loss of association with another Optical Network Navigator
module

Navis™ Optical PM - NP validates each fault event (raise and clear) it
receives from an EMS and checks the event for duplication. If the
alarm passes validation and uniqueness tests, then it is maintained and
processed. In validation, Navis™ Optical PM - NP checks that the
alarm is from a valid network element/EMS combination that it
manages. During uniqueness testing, Navis™ Optical PM - NP checks
that the alarm is not a duplicate of a particular alarm already received
by the NMS.

Raise and clear events

If an alarm or TCA raise event occurs and it does not exist on the
system, Navis™ Optical PM - NP maintains and processes the alarm or
TCA raise event. If an alarm or TCA clear event occurs and it does
not exist on the system, and if there is a peer raise event in the
system, Navis™ Optical PM - NP maintains and processes the alarm or
TCA clear event.

Double raise event

If a new raise darm or TCA event is received, where an existing raise
event exists, both records are kept. In this case, a clear event has been
missed for the first raise, and the user will need to perform a database
synchronization to resolve the instance of the double raise.
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Alarm collection

Alarm synchronization
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Alarm management concepts

Clear with no raise events

If Navis™ Optical PM - NP receives a new clear event for which there
IS no raise event, the clear event is dropped.

A synchronization of alarms can be performed with al supported
EMSs and Optical Network Navigator modules.

Navis™ Optical PM - NP provides on-line alarm synchronization for a
particular network element, for all the network elements controlled by
an EMS, and for al management alarms and TCAs on an EMS.

Alarm synchronization is automatically initiated in the following
instances:

« At system start up, Navis" Optical PM - NP performs an aarm
synchronization for all network elements as each EMS session is
established.

*  The system performs an alarm synchronization for a recovered
network element, when the system receives a network
element-status clear.

*  The system performs an alarm synchronization for a recovered
EMS for all controlled network elements.

The alarm synchronization can aso be manually initiated by the user
by performing database synchronizations with the EMSs and network
elements. For more information, refer to Navis™ Optical PM - NP
Administration Guide.
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Alarm classification

EMS alarms

Alarm groups

Alarm management concepts

Alarms are sent by the EMS, along with their mapped G7 2.0L
probable causes, to Navis™ Optical PM - NP. The alarms are then
mapped by Navis™ Optical PM - NP to an Alarm Group and Alarm
Category, which is used for sorting and filtering the alarms. The
mappings of fault notifications to the alarm groups use a combination
of the probable cause, alarm type, and service-affecting value. Navis™
Optica PM - NP also uses the mapping to determine whether
correlation is attempted for each alarm group. For those groups which
are correlated, Navis™ Optical PM - NP determines the fault state of
the alarmed object.

Navis™ Optical PM - NP uses a combination of the G7 2.0L probable
cause, dlarm type, and service impact to map fault notifications to the
Alarm Groups. This combination also determines whether or not
correlation is attempted for each Alarm Group. For those groups
which should be correlated, the Alarm Group determines the
processing required, and indicates the fault state of the source of the
alarm. For more information on correlation, refer to “Alarm
correlation” (4-8) in this information product.

The Navis™ Optical PM - NP Alarm Groups are as follows:
*  Environment (MDI and MDO)

*  Miscellaneous

 Timing

*  Equipment - uncorrelated

*  Equipment - correlated

. EMS

e  Threshold Crossings

*  Signd Fail - Primary

e Signa Fail - Loss of Multiframe
e Signa Fail - secondary

e  Signa degrade

*  Protection Switch

*  Misconnections

. NMS
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Alarm classification

Threshold crossing alerts

Alarm management concepts

Capacity Degrade
TCM Fail Primary
TCM Fail Secondary
TCM Signal Degrade
TCM Misconnections

The Alarm Group for all alarms raised by the Navis™ Optical PM -
NP is NMS, except for “NE loss of association alarms’, which are
mapped into the EMS Alarm Group. All of these are uncorrelated
alarms.

Navis™ Optical PM - NP can receive TCAS as either alerts or alarms
with the probable cause of "TCA."” In order to process al TCAsS,
Navis™ Optical PM - NP converts al aerts to alarms (maintaining the
probable cause of TCA) and processes them as detailed below.

1.

A trail 1D is appended to the TCA entry in the Alarm List,
however, the TCAs do not appear on the Traffic Correlated
Alarm List. TCAs are not propagated.

TCAs (both alarms and alerts) can be either persistent or
Instantaneous.

. Persistent TCAS are cleared when an interval occurs which
has error counts below threshold.

. Instantaneous TCASs are never cleared and must be
acknowledged and deleted by the user.

TCAs are resynced southbound following loss of association
between an EMS and network elements, between Navis™ Optical
PM - NP and the EMS, or automatically at start up.

Navis™ Optical PM - NP will forward these alerts and alarms
northbound in the format in which they were initially recieved.
(i.e. origina aerts are converted back to aert format.)

365-314-107R1.1
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Alarm classification

Alarm categories

Table 4-1 Alarm categories
Alarm Group

Environment

Miscellaneous

Timing

Equipment - uncorrelated

EMS

Threshold Crossings
Protection Switch

NMS

Alarm management concepts

The following list describes how Navis™ Optical PM - NP handles
TCAs:

« Navis™ Optical EMS: TCA data from Navis” Optical EMS is
converted into a G7 2.0L message and transmitted to Navis™
Optical PM - NP.

«  WaveStar® ITM-SC: Navis" Optical PM - NP converts the G7
2.0L message into a standard probable cause.

«  Navis™ Optical PM - NP: Navis" Optical PM - NP maps the
probable cause to an alarm and handles the alarm using the
normal alarm mechanisms.

If a G7 2.0L TCA event arrives containing multiple notifications,
Navis"” Optical PM - NP splits them out and handles them
individually. If they are passed on northbound, they are kept as
separate entities.

A trail ID is appended to the TCA entry in the Alarm List, however
the TCAs do not appear on the Traffic Correlated Alarm List. TCAs
are not propagated.

TCAs are resynched southbound following loss of association between
an EMS and network elements, between Navis™ Optical PM - NP and
an EMS, or automatically at start up.

Navis™ Optical PM - NP uses alarm categories to filter and sort
alarms on forms for fault management. Alarms that do not require
correlation are mapped to an alarm category as follows:

Alarm Category
Environment
Non-traffic
Non-traffic
Non-traffic

EMS

Threshold Crossing
Non-traffic

NMS
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Severity mapping  Navis" Optical PM - NP maps the severity of the alarm received from
an EMS to the severities used in G7 2.0L as follows.

Table 4-2  Severity mapping

Navis™ Optical Severity Notes

EMS

Critical Critical No equivalent to this in the prompt scheme. No
simple rules for knowing which prompt to make
critical.

Major Major

Minor Minor

Warning Warning

Indeterminate Indeterminate Indeterminate is used for the reported TCAs

because the severity can be prompt or info
depending on the source.

Navis™ Optical PM - NP performs mappings of severities for northbound equipment over some
interfaces as required (e.g. TIM). These mappings are as follows:

e  Critical: Prompt.

*  Major: Prompt.

*  Minor: Deferred.

*  Warning: Info.

* Indeterminate: Indeterminate.
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Alarm correlation

Introduction

Types of alarmed objects

Alarmed objects for
termination point alarms

Catalogued and
uncataloged connections

Alarm management concepts

Navis™ Optical PM - NP attempts to match the source of an alarm, of
which it may or may not have knowledge, to a network resource in its
managed network. The network resource to which the darm is
correlated becomes an alarmed object.

All alarms are mapped to an alarm group which requires correlation
are referred to as “correlatable.”

There are three possible types of alarmed objects:
»  Trail darmed object

*  Equipment alarmed object

*  Port alarmed object

Regardless of the outcome of the correlation process, the alarm is
mapped to the Traffic alarm category.

When a correlatable alarms is issued by a termination point, it is
correlated to a connection in the Navis™ Optical PM - NP database.
There are four possible results of this correlation:

* A *catalogued connection” which is not associated with an
Optical Network Navigator mesh connection is found. In this
case, the alarm is linked to a trail alarmed object.

* A “catalogued connection” which is associated with an Optical
Network Navigator mesh connection is found. In this case the
alarm is not linked to an alarmed object.

* An*uncataloged connection” is found. In this case the alarm is
linked to a port alarmed object.

. No connection is found. In this case the alarm is uncorrel ated
and is not linked to an alarmed abject.

In a transport network, a hierarchy of connections are defined. In the
Navis” Optical PM - NP database, it is possible to create a connection
at one of the client layers without the server layer in existence. Both
connections actually exist in the network, however, Navis™ Optical
PM - NP does not know of the server’s existence.
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Catalogued connection

Internally the Navis™ Optical PM - NP database is aware of the
created connection. The connection is referred to as a catalogued
connection.

A catalogued connections is associated with an Optical Network
Navigator mesh connection only if the catalogued connection the
alarm would be correlated to is:

« anoptical channel mesh connection which is managed by Optical
Network Navigator, or

e anoptica link connections whose client optical channel link
connection is used in an Optical Network Navigator mesh
connection, or is unused, but allocated to an Optical Network
Navigator domain.

Uncataloged connection

An uncataloged connection is any uncreated connection which has one
or more catalogued client connections.

Where the source of an alarm is a piece of equipment an equipment
alarm alarmed object is created. This darm may come with a list of
termination points, which Navis™ Optical PM - NP can match with
termination points used by “in-effect” trails to determine which trails
are affected by the equipment failure.

When an alarm is issued by a connection, Navis™ Optical PM - NP
will attempt to correlate it to a connection in the Navis™ Optical PM -
NP database. There are two possible results of this correlation:

1. A catalogued connection which is found. In this case an aarmed
object is created.

2.  No connection is found. In this case the alarm is uncorrel ated
and is not linked to an alarmed object.

When a failure occurs on a connection, Navis™ Optical PM - NP
indicates whether the cause of that failure occurred inside or outside
of the management domain. An internal failure is one that occurred
inside the management domain. An externa failure is one that
occurred outside the management domain.
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For each alarmed resource in the network, the alarmed object
indicates if the failure is internal or external.

* All equipment alarmed objects are internal.

»  For trail/port alarmed objects, whether the alarmed object is
internal or external depends on if the port is on the boundary of
the network.

- If the darm is raised on a boundary port, the alarmed object
is external.

- If thedarm israised on a non-boundary port, the alarmed
object is internal.

An aarmed object is considered to be part of an Optical Network
Navigator domains only the following conditions are met:

» the darmed object was created due to a connection alarm issued
by an Optical Network Navigator

» the adarmed object was created due to a termination point alarm
and was correlated to an optical link connection whose client
optical channel link connection is under control of Optical
Network Navigator.

The following are descriptions of boundary and non-boundary ports.
Boundary ports

A boundary port is one which is on the edge of the management
domain of Navis™ Optical PM - NP. A boundary port is identified by
checking the following:

1. The port is a connection termination point (CTP) which is cross
connected but not link connected to another termination point
within the management domain. This means it is the final port on
a catalogued connection which crosses the Navis™ Optical PM -
NP domain boundary.

A link connection to a black box does not count as a link
connection to a termination point.

2. The port is atrail termination point (TTP) in an uncataloged
connection, which has client connection termination points which
the circumstance described in (1) above. This means it is the
final port on an uncataloged connection which crosses the Navis”™
Optical PM - NP domain boundary.
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Non-boundary port

A non-boundary port is one which is in the middle of a connection.

The following alarms are ones that are correlated.
Protection switch alarms

There are two groups of alarms related to protection switching.

They are:

*  PSF - Protection Switch Fail. This group of alarms indicate that
protection switching has failed. This may be due to the protection
switch being locked, or it may be because both the service circuit
and protection have failed. Transmission protection switch
failures are mapped to the signal fail-primary alarm group.
Equipment protection switching failures are mapped to the
“equipment - traffic correlated” alarm group if they are on the
following:

trib cards

line cards

matrix and transfer boards

PPU’s (pointer processing units)
Otherwise, equipment protection switching failures are mapped to
the “equipment — uncorrelated” alarm group.

Equipment alarms

Equipment alarms have an indication of whether or not they are
service affecting. The possible service affecting values are:

* Unknown - (SA_UNKNOWN)

* Service faled - (SF_SERVICE_FAILED)

»  Service Degraded - (SD_SERVICE_DEGRADED)

* Non-service affecting - (NSA_NON_SERVICE_AFFECTING)

All equipment alarms are service failed, service degraded or
non-service affecting. All equipment alarms which are service failed
or service degraded are correlated. This means they result in an
equipment alarmed object.
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For equipment failures which impact traffic:

* Alarmsindicating a protected piece of equipment has failed are
marked as service degraded.

* Alarm indicating all the equipment in a protecting relationship
has failed are marked as service failed.
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Navis™ Optical PM - NP considers all trails and subnetwork
connections bidirectional. Therefore, a failure in either direction
indicates that the trail or subnetwork connection is no longer working.

Whenever a new adlarm raise or clear is correlated to an alarmed
object, Navis™ Optical PM - NP determines the fault state.

The following are the fault state values used in Navis™ Optical PM -
NP:

Failed

 For atral alarmed object, a fault state value of failed means that
traffic is not reaching at least one end point, either due to a direct
failure or an alarmed server failure.

*  For an equipment or a port alarmed object, it means there is no
protecting entity.
Degraded

 For atral alarmed object, this state means it has lost protection
at that layer, or the signal being transmitted by this connection
contains a high number of bit errors.

e  For an equipment alarmed object or a port alarmed object,
degraded means that either the working equipment or port has
failed, or that the protection equipment or port has failed.

Capacity degraded

This fault state is only supported for virtual concatenation groups. For
atraill alarmed object, there is no direct failure, but there is
insufficient server capacity to support full capacity requested for the
connection.

Working

For all alarmed objects, working means there are no alarms directly
correlated to this object, and it is not affected by any alarmed server
failure.

The following are direct fault states for alarmed objects.
Port Alarmed Objects

The fault state for a port associated with active alarms is aways
“failed,” unless the boundary port is protected, or the only associated
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alarm is for a signal degrade, in which case the fault state value is
“degraded.”

Important! Boundary ports on a Y-protection scheme are marked
as failed even if they are at the open end of the Y. It is the
propagation of the failure onto the trail that may result in a
degraded rather than a failed fault state.

Equipment alarmed objects

Navis™ Optical PM - NP uses the service-affecting value supplied
with the alarm to set the fault state.

Trail alarmed object
The trail may be an optical link, digital link, or a path layer trail.

Protection of these trails may be as follows:

 Adigita link may be protected by a bidirectional line switched
ring (BLSR).

* An Optical Multiplex Section (OMS) may be protected by
Optical Multiplex Section Protection (OMSP).

* An Optical Channel (OCh) path layer trail may be protected by
Optical Ring Switch (ORS) Protection, or by Optical Network
Navigator 1+1 or mesh protection.

For unprotected trails, at any layer associated with raise alarms, the
fault state is “failed” unless the only associated alarms are signal
degrade alarms, in which case the fault state value is “degraded.”

For an APS-protected digital link, the fault state is “degraded” if:
*  Only signal degrade alarms have been correlated to this trail.

A primary alarm is received on a port that is currently idle
(traffic is using the other port).
This may result in an incorrect fault state if two unrelated
unidirectional failures are received, which result in one direction
of traffic flowing on the service circuit SNC, and the other
direction on the protection SNC.

* Thefault state is “failed” if a primary alarm is received on a
active port (one which is carrying traffic).

For adigita link in a 2- or 4-fiber BLSR protection scheme, the fault
state is “failed” unless the only associated alarms are signal degrade
alarms, in which case the fault state value is “degraded.”
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For Optical Network Navigator protected optical channels, the
following applies:

»  Mesh protected: the fault state is always “failed”

e 1+1 protection: the fault state is “degraded” if one path has
failed. If both paths have failed the fault state is “failed”.

Fault state determination for a partially protected connection is based
on examining the unprotected and protected segments of the trail
separately, and then determining the impact of the trail as a whole.
Navis™ Optical PM - NP determines the fault state of the path to be
the highest severity of any segment in the trail, whether it is protected
or unprotected.

Navis™ Optical PM - NP determines the fault state for a protected
connection based on examining both unreliable bidirectional
subnetwork connections (SNCs). The fault state of the protected SNC
is determined as follows:

1. If protection switch failure is received for this protected SNC, the
fault state is “failed.”

2. If primary or secondary alarms are received on both unprotected
SNCs, then the protected SNC is “failed.”

3. If aprimary or secondary alarm is only received on one
unprotected SNC, the protected SNC is “degraded.”

Navis™ Optical PM - NP reassess the fault state whenever a new
alarm raise or clear is correlated to an alarmed object.

Objects on which alarms have been received are directly failed or
degraded. Because SONET and optical layers are hierarchical in
nature, a failure in the server layer has a consequential impact on any
client layers, resulting in an indirect failure of the client layers.

Only the server fault state of “failed and “working” are propagated to
the client layers. If the server fault state is “degraded,” the degraded
state is not propagated.

To assess the impact on client layers, Navis” Optical PM - NP
propagates the fault state to the client trails for all newly alarmed
objects. The fault state is a'so propagated to the client trails when the
fault state of the alarmed object changes.
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The following describes the indirect fault state of alarmed objects.
Trail alarmed objects
Faults on a server are propagated to all client trails.

The client trails each have their own fault state and become either
failed or degraded as a result of the server failure. The fault state of
an unprotected client matches the fault state of the server. However, if
a server is degraded rather than failed, the degraded state is not
propagated to its clients (so as to improve system performance).

For protected client trails, Navis™ Optical PM - NP performs more
complex assessments to determine the fault state.

If the server trail is a digital link, Navis™ Optical PM - NP checks
whether it belongs to a protection scheme, such as APS.

Equipment alarmed objects

For equipment alarmed objects with an Affected TP List, Navis™
Optical PM - NP propagates the failure to any trails using those
termination points. It then checks whether the trails are servers, and if
necessary, propagates the failure through the connection layer.

Port alarmed objects
Port alarmed objects may be PDH, SONET, Optical, or LAN.

For PDH port alarmed objects the associated connection will either be
a PDH circuit or a combo circuit. These will be services in their own
right and therefore the fault will only be propagated to a single
bi-directiona trail, or potentially two uni-directional client trails.

For SONET and Optical port alarmed objects the fault must be
propagated to any client TP's of those ports, and thus to any trails
using those client ports.

For Ethernet ports supporting virtual concatenation , there are no
clients defined in CM. Therefore, these connections can never be
uncatalogued and so cannot have a port alarmed object created on
them. For other Ethernet ports, or ports of unspecified format (e.g.
HSBB, LSBB), these can have port alarmed objects created on them.
In this case, the failure will be propagated to al clients of the
connection, in the same way as for SDH and optical ports.
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Alarms correlated directly to Optical Network Navigator domain link
connections or to connections that serve the Optical Network
Navigator domains are only propagated to Optical Network Navigator
unprotected and 1+1 protected optical channels and their clients.
Alarms that correlate directly to Optical Network Navigator domain
optical channel connections propagate all clients as normal.

It is possible for a trail to be both directly and indirectly failed. In this
case, the Navis™ Optical PM - NP uses the highest value of these two
failures.

Navis™ Optical PM - NP reassesses the fault state after the following
provisioning changes:

e  Trail creation

e Trail deletion

e  Tral modification

* MS-SPRING creation

* Inserting optical layersin adigita link

Trail creation

When atrail is provisioned, Navis” Optical PM - NP searches for:

« al aarms that can be correlated to the trail. If alarms are found,
each alarm is processed as if the alarm event was just received.
If there are associated alarms, then either the trail becomes a trall
alarmed object of the originating port becomes a port alarmed
object. For trail alarmed objects, Navis™ Optical PM - NP
determines whether it is a primary or secondary alarmed object.

o al directly or indirectly failed serving connections. The
provisioned trail becomes directly failed or degraded as
appropriate due to a failed server, as a result of the fault state
determination rules. If it is indirectly failed, then it appears in the
Affected Trails List, but not in the Traffic Correlated Alarm List.

Trail deletion

If a deprovisioned trail is atrail alarmed object, or the port at either
end was alarmed, Navis™ Optical PM - NP makes the trail alarmed
object or port alarmed object historic. Each of the alarms correlated to
the trail or port become uncorrelated alarms.

If a deprovisioned trail is one where the port at one end was the client
of a port alarmed object, Navis™ Optical PM - NP checks whether

365-314-107R1.1
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there are other trails served by the port alarmed object. If there are no
clients, the port alarmed object becomes historic and the associated
alarm becomes an uncorrelated alarm.

Trail modification

When a user adds or removes protection subnetwork connections, or
changes the route taken by a connection, including changes on one of
the end points, Navis™ Optical PM - NP reassesses the state of the
connection based on the new routing. As a result, alarms can change
from correlated to uncorrelated or vice versa. If the connection state
changes from failed of degraded to working, the alarm becomes
historic. If the connection changes state from failed to degraded or
vice versa, the alarm is updated on the Traffic Correlated Alarm List
and the original alarm becomes historic. If the connection state
changes and there are client connections, Navis™ Optical PM - NP
performs a fault state propagation.

MS-SPRING creation

When the user completes a ring that supports MS-SPRING, Navis™
Optical PM - NP checks whether any of the constituent digital links
are failed.

Inserting optical layers in a digital link

When a user adds optical layers into a digital link, Navis™ Optical
PM - NP checks the fault state of the connections. If any are failed,
then Navis™ Optical PM - NP performs a fault state propagation.

Navis™ Optical PM - NP makes some assumptions about network
element operation when determining the fault state.

Several network elements report secondary alarms on a trail
termination point as a result of a server failure. Several report
protection switch fail. Additionally, some network elements support
per instance report setting for alarms.

Where fault state determinations rely on using the end port server
signal fail/alarm indication signal and/or protection switch fail to
indicate that a protected connection has failed rather than just being
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degraded, this will only be guaranteed to be successful if both of the
following conditions exist:

1. The network elements used by the trail generate these types of
alarms.

2. The appropriate ports are within the management domain.

In the case when one or both ends of the client services are in the
management domain, the secondary alarms on the end ports are used
to indicate that the service has failed.

In the case where neither end is visible, then the presence of a
protection switch fail is used to determine the fault state of “failed.”

In the case where the end ports are not visible to the management
domain, and the network element supporting the protected cross
connection does not generate protection switch fail, the fault state
calculated by Navis™ Optical PM - NP is not guaranteed to be correct.

O]
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Alarm and alarmed object suppression

Introduction

Alarm suppression

Alarmed object
suppression

Primary and secondary

alarms

To limit the amount of information displayed to a user, Navis"
Optical PM - NP provides both alarm suppression and trail alarmed
object suppression, so that only the cause of a problem is indicated.

When a server fails, the network element detecting that failure could
generate alarms for all the clients of that server. Navis™ Optical PM -
NP receives the alarms for the server failure as a primary alarm. It is
possible (based on network element and EMS settings) to also receive
the client alarms as secondary alarms. Navis" Optical PM - NP
evaluates and determines whether alarms are primary or secondary.

Since Navis™ Optical PM - NP correlates both primary and secondary
alarms with trails, potentially the primary and secondary alarms will
result in multiple trail alarmed objects.

The user can achieve simple alarm suppression on the Alarm List by
filtering out all the alarms in the signal fail - secondary alarm group
field.

For every trail alarmed object, Navis™ Optical PM - NP determines
whether it is a primary or a secondary alarmed path. All port and
equipment alarmed objects are primary and are never suppressed.

Alarmed trail suppression is available both as an installation option
and as afilter option on the Traffic Correlated Alarm List. If trall
alarm suppression is chosen at installation time, secondary alarmed
paths do not appear on the Traffic Correlated Alarm List, however
secondary alarmed paths do display in the Affected Trails List.

Where alarmed trail suppression is not set at installation, the user can
filter out the secondary alarms on the Traffic Correlated Alarm List.

For every trail or port alarmed object, Navis™ Optical PM - NP
determines whether it is primary or secondary. This helps distinguish
the root cause (primary) of a failure from the alarms which may be a
consequence of that root cause alarm. Consequential (secondary)
alarms may be suppressed or filtered from view by the user.
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For connection alarms from Optical Network Navigator, primary or
secondary alarms are defined as follows:

. Connection failure alarms, where the connection is mesh
protected, are considered primary.

*  Connection failure alarms, where the connection is unprotected,
or 1+1 protected, are considered secondary.
O
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Service impact assessment

Introduction

Services

Service impact of alarmed

object

Service impact values

Navis™ Optical PM - NP assesses and reports on the service impact
for alarmed objects. The service impact assessment information
reported on user forms is the highest priority fault state of any of the
impacted services. Each time the fault state of an alarmed object
changes, Navis" Optical PM - NP reevaluates the service impact.

Services are trails that are in the path layer and are non-assignable.
Non-assignable trails do not have clients. Only services with
“in-effect” trails are considered when determining the service impact
for an alarmed object.

This section dezcribes the service impact of alarmed objects.
Trail alarmed objects

A trail alarmed object may be a service, or its client trails may be
services. An alarmed object can carry many services, but only the
highest priority failure is reported.

Equipment alarmed objects

For cards with equipment alarms with affected termination points, the
service impact reported is the highest priority fault state of the
affected trails.

For cards with no affected termination points, the service impact
reported is the same as the fault state.

Port alarmed objects

For PDH and SONET path layer ports, the service impact is the fault
state of the single impacted connection.

For al line ports and optical path layer ports, the service impact is the
highest priority fault state of the affected trails.

The values for service impact, are:

Working - all the associated alarms on the alarmed object have been
cleared, and its client services are not impacted by any other failures.

Service degraded - where the server is degraded or it will impact a
client on a protected SNC.

Lucent Technologies 365-314-107R1.1
Issue 1, July 2002



Service impact assessment Alarm management concepts

Capacity degraded - the server failure contributes to a insufficient
server capacity condition on a virtual concatenation group.

Service failed - where the server failure impacts a client on a
protected segment and the fault state of the client is failed because of
another alarm. Navis™ Optical PM - NP is not certain the server
failure is the cause of the client failure.

No services - the alarmed object is not carrying any services.

Calculating - Navis™ Optical PM - NP is still doing fault propagation,
this must be completed before the service impact can be determined.
O
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Navis™ Optical PM - NP has two types of alarm deletion:
1. Remova of alarms from the Alarm List.
2. Deletion of aarms from the system as a whole.

Navis™ Optical PM - NP provides two possible ways to discard new
alarms:

1. A configured deletion option set a installation time. For more
information, refer to “Installation options’ (1-16) in this
information product.

2. Automatic deletion initiated by the system because the
system-configured limit has been reached. When the number of
stored current alarms reaches 75% and 95% of the system limit,
Navis™ Optical PM - NP raises instantaneous platform alarms.

Once alarms are removed from the Alarm List, Navis™ Optical PM -
NP places them in the Alarm Log.

The limit for the number of alarm log records that are held in the
Alarm Log is 300,000. Navis™ Optical PM - NP provides three
possible ways to remove alarms from the system as a whole:

e Manual deletion of alarm log records from the Alarm Log.
I nstantaneous alarms must always be manually deleted. For more
information, refer to Chapter 2, “Fault management tasks’.

* Automatic deletion by the system when an alarm has been in the
Alarm Log for 30 days.

* Automatic deletion initiated by the system due to exhaustion of
file storage. When the number of stored current alarms reaches
75% and 95% of the system limit, Navis™ Optical PM - NP
raises instantaneous platform alarms. These serve to recommend
that the user archive alarm records if necessary. For more
information, refer to Chapter 2, “Fault management tasks’.
Upon reaching the 95% limit, Navis" Optical PM - NP attempts
to move 15% of the alarm log records from the system.

O]
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Alarm acknowledgement

Introduction  Alarm acknowledgement is about recognizing alarms raised on the
network. A user can always acknowledge a raised alarm. Depending
on options set for alarm deletion at installation, it may also be
necessary for the user to acknowledge a clear.

Navis™ Optical PM - NP retains the following acknowledgement
details:

*  Acknowledgement date and time
*  Acknowledgement user

Acknowledging alarms  Alarms are acknowledged from both the Alarm List and the Traffic
Correlated Alarm List.

Traffic Correlated Alarm List acknowledgement

A user can acknowledge all alarms from the Traffic Correlated Alarm
List, regardless of the fault management operational mode sel ected.

When a user requests acknowledgement from the Traffic Correlated
Alarm list, all associated alarms are acknowledged. The
acknowledgement details are displayed in both the Traffic Correlated
Alarm List and associated Alarm List records. When new alarms are
received, the acknowledgement details are reset in the Traffic
Correlated Alarm List. This does not, however, reset the
acknowledgement for the associated alarms in the Alarm List.

A user can request multiple records for acknowledgement at one time.
Alarm List acknowledgement

From the Alarm List, which alarms can be acknowledged depends on
the fault management operational mode the user has selected.

» Alarm Approach Mode - In this mode, the user can acknowledge
any of the alarms from the Alarm List.
Acknowledgement details display in the Traffic Correlated Alarm
List only if the alarmed object is acknowledged, and no new
associated alarm is subsequently raised. If a new associated alarm
is raised, then the acknowledgement details are reset.
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In the case where, due to user acknowledgement from the Alarm
List, there is more than one set of acknowledgement details
associated with an alarmed object, only the most recently
acknowledged alarm displays in the Traffic Correlated Alarm
List. The user can access the Alarm List from the Traffic
Correlated Alarm List to view the complete acknowledgement
details for each associated alarm.

e Service Approach Mode - In this mode, a user can only
acknowledge uncorrelated alarms from the Alarm List. Correlated
alarms must be acknowledged from the Traffic Correlated Alarm
List.

O
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Optical Network Navigator

Background

domain

Navis™ Optical PM - NP provides filtering for Service Domain
Partitioning users.

The Optical Network Navigator domain manages connectivity between
Optical Network Navigator controlled network elements, including
their associated ports. Also included in the domain are ports on
Optical Network Navigator controlled network elements that form the
edge of the domain. Once this connectivity and these ports are
assigned, they are available for the Optical Network Navigator to use
in provisioning.
A termination point is considered part of the Optical Network
Navigator domain if it is:
* anoptical channel termination point which is part of the Optical
Network Navigator domain.

e anoptica link termination point which is assigned to the Optical
Network Navigator domain.

OJ
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Trouble ticket process
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Trouble tickets are used to record the information regarding how a
problem is being resolved.

Trouble tickets are created, modified or deleted by selecting the
appropriate record on the Alarm List or Traffic Correlated Alarm List.

To attach a trouble ticket to an existing repeat alarm, the user must
select the identical current alarm from the Alarm List. Once it is
created, the trouble ticket applies to the current alarm its associated
repeat alarms. The trouble ticket only displays the current alarm for
the repeated alarm set.

Repeat alarms are only deleted for a trouble ticket when the identical
current alarm in the Alarm List is deleted. When the current dlarm is
deleted, all repeat alarms are also deleted.

When all associated alarms or the alarmed object are deleted (made
historic) from either the Alarm List or the Traffic Correlated Alarm
List, the associated trouble ticket is automatically made historic.

When using the Service Approach Mode the user is not allowed to
create trouble tickets for traffic correlated aarms in the alarm list.
When using the Alarm Approach Mode, the user can create trouble
tickets from either the Alarm List or the Traffic Correlated Alarm List.
O
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5 Fault management fault lists

Overview
Purpose  This chapter contains aarm lists for the network elements and EM Ss
that Navis™ Optical PM - NP supports.
Contents
Section |: Navis” Optical EMS fault lists 5-2
Navis™ Optical EMS management alarms 5-3
Navis™ Optical EMS: WaveStar® BandWidth 5-4
Manager and OC192 network elements fault list
Navis™ Optical EMS: WaveStar® OLS 1.6T Family 5-6
fault list
Navis"” Optical EMS: LambdaRouter™ AOS fault 5-7
list
Section 11: Navis” Optical PM - NP fault lists 5-8
Navis™ Optical PM - NP fault list 5-9
[
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Section I: Navis™ Optical EMS fault lists

Overview
Purpose  This section contains fault lists for the Navis™ Optical EMS and
network elements
Contents
Navis™ Optical EMS management alarms 5-3
Navis™ Optical EMS: WaveStar® BandWidth 5-4
Manager and OC192 network elements fault list
Navis™ Optical EMS: WaveStar® OLS 1.6T Family 5-6
fault list
Navis™ Optical EMS: LambdaRouter™ AOS fault 5-7
list
O
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Navis' Optical EMS management alarms

Overview

Displaying the fault list
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This list provides mapping and classification information for each
alarm, identified by its unique fault type.

The table consists of the following fields:

e Fault: network element fault type.

»  Text: the text for the network element fault type.

e G720 PC: the mapping to the G7 2.0 probable cause.

« R/NR: values of “R”, for reported to Navis" Optical PM - NP, or
“NR” for not reported to Navis™ Optical PM - NP,

*  Persistency: lists whether the alarm is persistent or transient.

The fault list can be viewed using browser software in the following

ways:

» By clicking on the link below from the on-line version of this
document

« By navigating to afile in the Navis™ Optical PM - NP software

Linking from the Navis™ Optical PM - NP on-line documentation

If you are viewing the HTML version of this document (accessed by
executing Help > On-line Documents from the Network Map), click
on the following link to access the fault list.

Important! If you are viewing the .pdf version of this document
on-line, the link does not display on this page.

Navigating to a file in the Navis™ Optical PM - NP software

The fault list file is included in the Navis™ Optical PM - NP software.
You can open the fault list file with a browser if the Navis™ Optical
PM - NP software is loaded on the personal computer. The following
is the path and file for the fault list in the Navis™ Optical PM - NP
software:

c:\jui\bin\jnm\itm\help\appl\lang\english\doc\fault-
Tists\snms_mgmt_alarms.html

Important! The PC must contain the Navis™ Optical PM - NP
software.
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Section I: Navis™ Optical EMS fault lists Fault management fault lists

Navis~ Optical EMS: WaveStar® BandWidth Manager and
OC192 network elements fault list

Overview

Displaying the fault list

This list provides mapping and classification information for each
alarm, identified by its unique Fault Type.

The table consists of the following fields:

*  Fault: network element fault type.

*  Text: the text for the network element fault type.

« G720 PC: the mapping of the fault to the G7 2.0 probable
cause.

+  NMS Service Affecting: a Navis™ Optical PM - NP service
affecting value of SA_SERVICE_FAILED,
SA_SERVICE_DEGRADED, SA_NON_SERVICE_AFFECTING
or SA_UNKNOWN.

«  Reporting to NMS: values of “R”, for reported to Navis™ Optical
PM - NP, or “NR” for not reported to Navis" Optical PM - NP,

*  Pergistency: lists whether the dlarm is persistent or transient.

The fault list can be viewed using browser software in the following

ways.

* By clicking on the link below from the on-line version of this
document

« By navigating to afile in the Navis” Optica PM - NP software

Linking from the Navis™ Optical PM - NP on-line documentation

If you are viewing the HTML version of this document (accessed by
executing Help > On-line Documents from the Network Map), click
on the following link to access the fault list.

Important! If you are viewing the .pdf version of this document
on-line, the link does not display on this page.

Navigating to a file in the Navis™ Optical PM - NP software

The fault list file is included in the Navis™ Optical PM - NP software.
You can open the fault list file with a browser if the Navis™ Optical
PM - NP software is loaded on the PC. The following is the path and
file for the fault list in the Navis™ Optical PM - NP software:

c:\juiNbin\jnm\itm\help\appl\lang\english\doc\fault-
Tists\BWM_etc.html

Lucent Technologies 365-314-107R1.1
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Section |: Navis" Optical EMS fault lists Fault management fault lists
Navis™ Optical EMS: WaveStar®
BandWidth Manager and OC192 network
elements fault list .
Important! The PC must contain the Navis™ Optical PM - NP
software.

OJ
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Section I: Navis™ Optical EMS fault lists Fault management fault lists

Navis~ Optical EMS: WaveStar® OLS 1.6T Family fault list

Overview

Displaying the fault list

This list provides mapping and classification information for each
alarm, identified by its unique fault type.

The table consists of the following fields:

*  Fault Type: network element fault type.

»  Text: the text for the network element fault type.

« G7 2.0 PC: the mapping to the G7 2.0 probable cause.

«  NMS Service Affecting: a Navis" Optical PM - NP service
affecting value of SA_SERVICE_FAILED,
SA_SERVICE_DEGRADED, SA_NON_SERVICE _AFFECT-
ING.

+  Reporting to NMS: values of “R”, for reported to Navis™ Optical
PM - NP, or “NR” for not reported to Navis™ Optical PM - NP,

*  Persistency: lists whether the alarm is persistent or transient.

The fault list can be viewed using browser software in the following

ways:

* By clicking on the link below from the on-line version of this
document

« By navigating to a file in the Navis™ Optical PM - NP software

Linking from the Navis™ Optical PM - NP on-line documentation

If you are viewing the HTML version of this document (accessed by
executing Help > On-line Documents from the Network Map), click
on the following link to access the fault list.

Important! If you are viewing the .pdf version of this document
on-line, the link does not display on this page.

Navigating to a file in the Navis™ Optical PM - NP software

The fault list file is included in the Navis™ Optical PM - NP software.
You can open the fault list file with a browser if the Navis™ Optical
PM - NP software is loaded on the PC. The following is the path and
file for the fault list in the Navis™ Optical PM - NP software:

c:\juibin\jnm\itm\help\appl\lang\english\doc\fault-
Tists\snms_olsl.6t.html

Important! The PC must contain the Navis™ Optical PM - NP
software.
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Section |: Navis" Optical EMS fault lists Fault management fault lists

Navis Optical EMS: LambdaRouter™ AOS fault list

Overview

Displaying the fault list

365-314-107R1.1
Issue 1, July 2002

This list provides mapping and classification information for each
alarm, identified by its unique Fault Type.

The table consists of the following fields:
*  Fault Type: network element fault type.
e  Text: the text for the network element fault type.

« G7 2.0 PC: the mapping of the fault to the G7 2.0 probable
cause.

« NMS SA: aNavis™ Optical PM - NP service affecting value of
SA_SERVICE_FAILED, SA_SERVICE_DEGRADED,
SA_NON_SERVICE_AFFECTING or SA_UNKNOWN.

*  Reporting to NMS: values of “R”, for reported to Navis™ Optical
PM - NP, or “NR” for not reported to Navis™ Optical PM - NP,

*  Persistency: lists whether the alarm is persistent or transient.

The fault list can be viewed using browser software in the following

ways.

* By clicking on the link below from the on-line version of this
document

« By navigating to a file in the Navis™ Optical PM - NP software

Linking from the Navis™ Optical PM - NP on-line documentation

If you are viewing the HTML version of this document (accessed by
executing Help > On-line Documents from the Network Map), click
on the following link to access the fault list.

Important! If you are viewing the .pdf version of this document
on-line, the link does not display on this page.

Navigating to a file in the Navis™ Optical PM - NP software

The fault list file is included in the Navis™ Optical PM - NP software.
You can open the fault list file with a browser if the Navis™ Optical
PM - NP software is loaded on the PC. The following is the path and
file for the fault list in the Navis™ Optical PM - NP software:

c:\Jjuibin\jnm\itm\help\appl\lang\english\doc\fault-
lists\snms_Tambdarouter.html

Important! The PC must contain the Navis™ Optical PM - NP
software.
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Fault management fault lists

Section I1: Navis~ Optical PM - NP fault lists

Overview
Purpose  This section contains the Navis™ Optical PM - NP fault lists.
Contents
Navis™ Optical PM - NP fault list 5-9
]
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Section I1: Navis™ Optical PM - NP fault Fault management fault lists

lists

Navis Optical PM - NP fault list

Overview

Displaying the fault list

365-314-107R1.1
Issue 1, July 2002

This table provide a list of the system, element management and
network element related alarms generated by the Navis™ Optical PM -
NP

The table consist of the following fields:

*  Fault: this field contains the fault identifier.

» Text: this field contains the descriptive text displayed for the
alarm.

*  Sev: thisfield contains the default severity of the alarm. This can
be CRITICAL, MAJOR, MINOR or WARNING.

* Levdl: this defines the alarm category as a network management
alarm (NMS), an element management system alarm (EMS) or a
network element related alarm (NE).

*  Pers: this defines whether the alarm is persistent (PERS) or
instantaneous (INST).

e Cause: this defines the cause of the alarm.
Comments: this field contains any other relevant information.

The fault list can be viewed using browser software in the following

ways.

* By clicking on the link below from the on-line version of this
document

« By navigating to afile in the Navis™ Optical PM - NP software

Linking from the Navis™ Optical PM - NP on-line documentation

If you are viewing the HTML version of this document (accessed by
executing Help > On-line Documents from the Network Map), click
on the following link to access the fault list.

Important! If you are viewing the .pdf version of this document
on-line, the link does not display on this page.

Navigating to a file in the Navis™ Optical PM - NP software

The fault list file is included in the Navis™ Optical PM - NP software.
You can open the fault list file with a browser if the Navis" Optical
PM - NP software is loaded on the PC. The following is the path and
file for the fault list in the Navis™ Optical PM - NP software:

Lucent Technologies 5-9



Section 11: Navis™ Optical PM - NP fault Fault management fault lists
lists
Navis™ Optical PM - NP fault list

c:\Jjuibin\jnm\itm\help\appI\lang\english\doc\fault-
Tists\ws-nms.html

Important! The PC must contain the Navis” Optical PM - NP
software.
[l
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6 Performance monitoring
parameters

Overview

Purpose

Contents

This chapter describes performance monitoring concepts as related to

Navis™ Optical PM - NP.

Section |: Performance monitoring parameters

Performance monitoring parameters

Termination point performance parameters

Monitoring points

Metropolis™ EON performance monitoring
parameters
Ethernet performance monitoring data

Optical network termination point performance
parameters
Section |1: Threshold setting parameters

Threshold setting

Optical threshold crossing alert parameters

Threshold crossing alert parameters

Section I11: Trail Types
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Overview Performance monitoring parameters

Connection level and trail types. WaveStar® 6-24
BandWidth Manager, WaveStar® TDM 2.5/10G,
and WaveStar® OLS 1.6T
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Performance monitoring parameters

Section |: Performance monitoring parameters

Overview

Purpose

Contents

The purpose of this section is to provide the user with information

about the performance monitoring parameters utilized by Navis™

Optica PM - NP,

Performance monitoring parameters

Termination point performance parameters

Monitoring points

Metropolis™ EON performance monitoring
parameters
Ethernet performance monitoring data

Optical network termination point performance
parameters
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Section |: Performance monitoring Performance monitoring parameters
parameters

Performance monitoring parameters

Overview Navis" Optical PM - NP supports both near-end and far-end
parameters.

Performance parameters  The following table lists performance monitoring parameters.
Near-end parameters are prefixed with “ne”’, and far-end parameters
are prefixed with a “fe”. For example, "nebbe”’ stands for “near-end
backgrounds block errors’, and “fecv” stand for “far-end code
violations'.

Table 6-1 Performance monitoring parameters

Parameter Description

es Errored Seconds

esa Errored Seconds Type A

esb Errored Seconds Type B

ses Severely Errored Seconds

uas Unavailable Seconds

bbe Backgrounds Block Errors

cv Code Violations

ofs Out of Frame Seconds

loss Loss of Signal Seconds

fc Failure Counts

sefs Severely Errored Frame Seconds

psc Protection Switch Count

pscs Protection Switch Count (Span Switching)

pscr Protection Switch Count (Ring Switching)

psd Protection Switch Duration

sas Severely Errored Frame (SEF)/Alarm Indication Signal (AlS) Seconds

aiss Alarm Indiction Signal Seconds

fecc Forward Error Correction Corrected

fecu Forward Error Correction Uncorrected

ppjcg Positive Pointer Justification Generated

npjcg Negative Pointer Justification Generated
6-4 Lucent Technologies 365-314-107R1.1
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Section |: Performance monitoring

parameters

Performance monitoring parameters

Table 6-1 Performance monitoring parameters (continued)
Parameter Description

ppjcd Positive Pointer Justification Detected

npjcd Negative Pointer Justification Detected

Ibc Laser Bias Current

Ibc-pl Pump Laser Efficiency

opr Optical Power Received

opt Optical Power Transmitted

spr-c Signal Power Received — Optical Channel

spt-c Signal Power Transmitted — Optical Channel

topr-ol Total Optical Power Received — Optical Line

topt-ol Total Optical Power Transmitted — Optical Line

Performance monitoring parameters

365-314-107R1.1
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Section |: Performance monitoring Performance monitoring parameters
parameters

Termination point performance parameters

Termination point  The following table lists the termination point performance parameters
performance parameters  for the supported SONET network elements.

Table 6-2 Termination point performance parameters per supported network element

Monitored WaveStar® WaveStar® Metropolis™ Metropolis™ LambdaUnite
termination OLS 2.5G/10G BWM DMX DMXpress
point
Physical LBC LBC
(PITTP) OPT OPT
OPR OPR
Section NE-CV NE-CV NE-CV NE-SEFS NE-CV
(RSTTP) NE-ES NE-ES NE-SEFS (0C48) NE-ES
NE-SES NE-SES (0C192, NE-SES
NE-SEFS NE-SEFS 0Ca8, OC12, NE-SEFS
- - 0C3, EC1) i
NE-LOSS NE-LOSS NE-LOSS
(0OC192, OC48, (0C192, (0C192, OC48,
0OC12, OC3) 0C48, 0OC12, 0C12, 0OC3)
oc3)
6-6 Lucent Technologies 365-314-107R1.1
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Section |: Performance monitoring

parameters

Termination point performance parameters

Performance monitoring parameters

Table 6-2 Termination point performance parameters per supported network element

Line
(MSTTP)

STS1

(continued)
NE-CV
NE-ES
NE-SES
NE-UAS
NE-AISS
NE-FC

NE-FECC -
0C192 only

NE-FECU -
0C192 only

NE-PSC -
excludes 4F
rings
NE-PSCS - 4F
rings only

NE-PSCR -
excludes 4F
rings (OC192,
0C48, OC12,
OC3, EC1).

NE-CV
NE-ES
NE-SES
NE-UAS
NE-FC
PPICG
NPICG
PPJCD
NPJCD

NE-CV
NE-ES
NE-SES
NE-UAS
NE-AISS
NE-FC

NE-FECC -
0C192 only

NE-FECU -
0C192 only

NE-PSC -
excludes 4F
rings
NE-PSCS - 4F
rings only

NE-PSCR -
excludes 4F
rings (OC192,
0C48, 0OC12,
OC3, EC1).

NE-CV
NE-ES
NE-SES
NE-UAS
NE-FC
PPICG
NPICG
PPJCD
NPJCD

NE-CV
NE-ES
NE-ESA
NE-ESB
NE-SES
NE-UAS
NE-PSC

NE-PJC -
(0C192,
0C48, OC12,
OC3, EC1).

NE-CV
FE-BE
NE-ES
NE-ESA
NE-ESB
NE-SES

NE-UAS,
DMP

NE-CV
NE-ES
NE-ESA
NE-ESB
NE-SES
NE-UAS
NE-PSC

NE-PJC - (
0C48).

NE-CV

NE-BE

NE-ES
NE-ESA
NE-ESB
NE-SES
NE-UAS, DMP

NE-CV
NE-ES
NE-SES
NE-UAS
NE-AISS
NE-FC

NE-FECC -
0C192 only

NE-FECU -
0C192 only
(OC192, OC4s8,
0OC12, OC3)

NE-CV
NE-ES
NE-SES
NE-UAS
NE-FC
PPICG
NPICG
PPJCD
NPJCD
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Section |: Performance monitoring

parameters

Termination point performance parameters

Performance monitoring parameters

Table 6-2 Termination point performance parameters per supported network element

(continued)
NE-CV
NE-ES
NE-SES
NE-UAS
NE-FC
PPJCG
NPJCG
PPJCD
NPJCD
NE-CV
NE-ES
NE-SES
NE-UAS
NE-FC
PPJCG
NPJCG
PPJCD
NPJCD
NE-CV
NE-ES
NE-SES
NE-UAS
NE-FC
PPJCG
NPJCG
PPJCD
NPJCD

STS-3c

STS-12¢

STS-48¢c

NE-CV NE-CV
NE-ES FE-BE
NE-SES NE-ES
NE-UAS NE-ESA
NE-FC NE-ESB
PPJCG NE-SES
NPJCG NE-UAS,
PPJCD DMP
NPJCD

NE-CV NE-CV
NE-ES FE-BE
NE-SES NE-ES
NE-UAS NE-ESA
NE-FC NE-ESB
PPJCG NE-SES
NPJCG NE-UAS,
PPJCD DMP
NPJCD

NE-CV

NE-ES

NE-SES

NE-UAS

NE-FC

PPICG

NPJCG

PPJCD

NPJCD

NE-CV

FE-BE

NE-ES
NE-ESA
NE-ESB
NE-SES
NE-UAS, DMP

NE-CV

FE-BE

NE-ES
NE-ESA
NE-ESB
NE-SES
NE-UAS, DMP

NE-CV
NE-ES
NE-SES
NE-UAS
NE-FC
PPJCG
NPICG
PPJCD
NPJCD
NE-CV
NE-ES
NE-SES
NE-UAS
NE-FC
PPJCG
NPJCG
PPJCD
NPJCD
NE-CV
NE-ES
NE-SES
NE-UAS
NE-FC
PPJCG
NPJCG
PPJCD
NPJCD

Lucent Technologies

365-314-107R1.1
Issue 1, July 2002



Section |: Performance monitoring

parameters

Termination point performance parameters

Performance monitoring parameters

Table 6-2 Termination point performance parameters per supported network element

STS-192c

VT1.5
(DS1/TY)

(continued)

NE-CV

NE-ES

NE-SES

NE-UAS

NE-FC

PPJCG

NPICG

PPJCD
NE-CV
FE-BE
NE-ES
NE-ESA
NE-ESB
NE-SES
NE-UAS,
DMP

365-314-107R1.1
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NE-CV
NE-ES
NE-SES
NE-UAS
NE-FC
PPJCG
NPICG
PPJCD
NPJCD
NE-CV
FE-BE
NE-ES
NE-ESA
NE-ESB
NE-SES
NE-UAS, DMP
0J
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Section I: Performance monitoring Performance monitoring parameters
parameters

Monitoring points

Performance monitoring  The following table lists the performance monitoring monitoring
monitoring points  points for the supported SONET network elements.

Table 6-3 Supported performance monitoring points per supported network element

Monitored WaveStar® OLS = WaveStar® BWM Metropolis™ DMX Metropolis™
termination 2.5G/10G DMXpress
point
T1 Line NE-ES
T1 Path NE-CV NE-CV
NE-ES FE-CV
NE-SES NE-ES
NE-SEFS FE-ES
NE-LOSS NE-SES
(0C192, OC48, FE-SES
0C12, 0OC3)
NE-UAS
FE-UAS
T3 Line NE-CV NE-CV NE-CV NE-CV
NE-ES NE-ES NE-ES NE-ES
NE-SES NE-SES NE-SES NE-SES
NE-LOSS NE-LOSS
6-10 Lucent Technologies 365-314-107R1.1
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Section |: Performance monitoring

parameters

Monitoring points

Performance monitoring parameters

Table 6-3 Supported performance monitoring points per supported network element

T3 Path

(continued)
NE-CV
NE-ES
NE-ESA
NE-ESB
NE-SES
NE-SAS
NE-AISS
NE-UAS
NE-FC
PPJCG
NPJCG
PPJCD
NPJCD
FE-CV
FE-ES
FE-SES
FE-UAS
FE-FC

NE-CV
NE-ES
NE-ESA
NE-ESB
NE-SES
NE-SAS
NE-AISS
NE-UAS
NE-FC
PPICG
NPJCG
PPJCD
NPJCD
FE-CV
FE-ES
FE-SES
FE-UAS
FE-FC

NE-CV
FE-CV
NE-ES
FE-ES
NE-SES
FE-SES
NE-UAS
FE-UAS
NE-SEFS

NE-CV
FE-CV
NE-ES
FE-ES
NE-SES
FE-SES
NE-UAS
FE-UAS
NE-SEFS
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Section |: Performance monitoring Performance monitoring parameters
parameters

Metropolis~ EON performance monitoring parameters

Metropolis™ EON  The following table lists the Metropolis™ EON monitoring points.

T monitoring POJMNS o _
able 6-4 Metropolis™ EON monitoring points
SNMS-EML Name Navis™ Name Connection Level Analogue Counters OLS
(GUI) Metropolis™ EON
Optical Channel OCHTTP OchTralil SPR-C
Section RSTTP NE-CV
NE-ES
NE-SES
NE-SEFS
OTPS PITTP oL OPR (sink)

OPT (source)
LBCL (source)
Optical Line OTSTTP OMS TOPR-OL
TOPT-OL
OSNR-OL
LBC-P1
LBC-P2
LBFC-P1
LBFC-P2
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Section |: Performance monitoring Performance monitoring parameters
parameters

Ethernet performance monitoring data

Ethernet performance  The following table lists Ethernet performance monitoring data.

monitoring data o
Table 6-5 Ethernet performance monitoring data

Monitored termination point DMX DMxpress
ENET (Ethernet port or VCG) EDFC EDFC
EDFE EDFE
EINB EINB
EINF EINF
EONB EONB
EONF EONF
[
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Section |: Performance monitoring Performance monitoring parameters
parameters

Optical network termination point performance parameters

Background  Optical channel monitoring is possible independently with analog and
digital counters, depending on the hardware present. Analog
monitoring is possible whenever an OMON (Optical Monitor) device
is present. Digital monitoring is possible whenever a WaveWrapper
OTU or a OCh Repeater OTU is present. Navis™ Optical PM - NP
does not check the presence of this equipment before allowing
monitoring to be configured.

For WaveStar® OLS 1.6T, both digital and analog parameters share
the optical channel termination point (OCHTTP).
WaveStar® OLS 1.6T  The following table lists the optical network termination point
optical parameters  performance parameters for WaveStar® OLS 1.6T.

Table 6-6 Optical network termination point performance parameters for WaveStar® OLS

1.6T
SNMS-EML Name Navis Optical Digital Counters WaveStar® Digital Counters WaveStar® Analog Counters All
PM - NP Name OLS400G R5.0 and prior OLS400G R6.0 and above WaveStar® OLS400G releases
Optical Channel OCHTTP FEC-EC SPR-C (per channel
FEC-UBC signal power received)
SPT-C (per channel
signal power transmitted
RS RSTTP NE-CV-BBE NE-CV-BBE
NE-ES NE-ES
NE-SES NE-SES
NE-SEFS NE-SEFS
Physical/OTPS PITTP OPR (optical power
received)
OPT (optical power
transmitted)
LBC (laser bias current)
6-14 Lucent Technologies 365-314-107R1.1
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Section |: Performance monitoring

parameters

Optical network termination point
performance parameters
Table 6-6 Optical network termination point performance parameters for WaveStar® OLS

SNMS-EML Name

Optical Line

Navis " Optical

PM - NP Name

OTSTTP

1.6T (continued)

Digital Counters WaveStar®

OLS400G R5.0 and prior

Digital Counters WaveStar®

OLS400G R6.0 and above

Performance monitoring parameters

Analog Counters All

WaveStar® OLS400G releases

TOPR-OL (total optical
power received)
TOPT-OL (Total optical
power transmitted
PLE-TPN (Pump laser
efficiency — transmit
pump N, N=1..6)
PLE-RPN (pump laser
efficiency — receive
pump N, N=1..6)

365-314-107R1.1
Issue 1, July 2002

Lucent Technologies



Performance monitoring parameters

Section II: Threshold setting parameters

Overview
Purpose  The purpose of this section is to provide the user with the threshold
setting parameters utilized by Navis™ Optical PM - NP,
Contents
Threshold setting 6-17
Optical threshold crossing alert parameters 6-18
Threshold crossing alert parameters 6-19
L]
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Section Il: Threshold setting parameters Performance monitoring parameters

Threshold setting

Overview

Threshold crossing alerts

Threshold crossing alert

processing

An important component of the performance monitoring feature is the
setting of a threshold value.

A threshold value is set for each performance monitoring data
parameter at a selected termination point on an SDH transport
connection. When this connection is exceeded, a threshold crossing
alert (TCA) israised to indicate that the signal quality has fallen
below a pre-set value.

The performance monitoring feature allows only for the viewing and
setting of TCA parameters. All other aspects of TCAs are handled by
the Navis™ Optical PM - NP fault management feature.

Navis™ Optical PM - NP allows the user to set each of the TCA
parameter values for one or two ports associated with a selected
transport connection, on a per granularity basis. The EMSs maintain a
raise and a clear value for each TCA parameter. The EMSs set both
values to the single value supplied by Navis™ Optical PM - NP.

O

365-314-107R1.1
Issue 1, July 2002

Lucent Technologies 6-17



Section Il: Threshold setting parameters Performance monitoring parameters

Optical threshold crossing alert parameters

Optical threshold crossing  The following lists the optical threshold crossing alert parameter
alert parameters  settings. All the thresholds in the table are “Low” with the exception
of LBC, which is “High.”

Table 6-7 Optical threshold crossing alert parameter settings
Monitored Termination Point Digital Counters OLS 1.6T Analog Counters OLS 1.6T

OCHTTP SPR-C (per channel signal power received)
SPT-C (per channel signal power transmitted

PITTP 1 LBC (laser bias current)?
OTSTTP TOPR-OL (total optical power received)
TOPT-OL (Total optical power transmitted
PLE-TPN (Pump laser efficiency — transmit pump
N, N=1..6)
PLE-RPN (pump laser efficiency — receive pump
N, N=1..6)
Notes:
1. The FEC counters are moved to the Physical layer. Navis™ Optical PM
- NP does not show FEC counters against the Physical layer.
2.  OPR and OPT thresholds cannot be modified by the user, therefore
they are now shown in this table.
U
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Section Il: Threshold setting parameters

Performance monitoring parameters

Threshold crossing alert parameters

Threshold crossing alert

parameters

The following table lists the threshold crossing alert parameters for
the supported SONET network elements.

Table 6-8 Threshold crossing alert parameters per supported network element

Monitored
termination
point

Physical
(PITTP)

Section
(RSTTP)

WaveStar®

OLS 2.5G/10G

LBC

OPT

OPR
NE-CV-BBE
NE-ES
NE-SES
NE-SEFS

NE-LOSS
(0C192,
0C48, OC12,
0C3)

WaveStar®
BWM

LBC

OPT

OPR
NE-CV-BBE
NE-ES
NE-SES
NE-SEFS

NE-LOSS
(OC192,
0C48, OC12,
0C3)

Metropolis™ Metropolis™ LambdaUnite

DMX DMXpress
NE-CV-BBE  NE-SEFS
NE-SEFS (OC48)
(0C192,
0C48, OC12,
0C3, EC1)
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Section Il: Threshold setting parameters
Threshold crossing alert parameters

Table 6-8 Threshold crossing alert parameters per supported network element

NE-CV-BBE
NE-ES
NE-SES
NE-UAS
NE-AISS
NE-FC

NE-FECC -
0C192 only

NE-FECU -
0C192 only

NE-PSC -
excludes 4F
rings

NE-PSCS - 4F
rings only

NE-PSCR -
excludes 4F
rings only

NE-PSD -
excludes 4F
rings (0C192,
0C48, 0OC12,
OC3, EC1).

NE-CV-BBE
NE-ES
NE-SES
NE-UAS
PPICG
NPICG
PPJCD
NPJCD

Line
(MSTTP)

STS1

NE-CV-BBE
NE-ES
NE-SES
NE-UAS
NE-AISS
NE-FC

NE-FECC -
0OC192 only

NE-FECU -
0OC192 only

NE-PSC -
excludes 4F
rings

NE-PSCS - 4F
rings only

NE-PSCR -
excludes 4F
rings only

NE-PSD -
excludes 4F
rings (0C192,
0C48, 0OC12,
0OC3, EC1).

NE-CV-BBE
NE-ES
NE-SES
NE-UAS
PPICG
NPJCG
PPJCD
NPJCD

NE-CV-BBE
NE-ES
NE-ESA
NE-ESB
NE-SES
NE-UAS
NE-PSC

NE-PJC -
(OC192,
0C48, OC12,
OC3, EC1).

NE-CV-BBE
FE-BE
NE-ES
NE-ESA
NE-ESB
NE-SES

NE-UAS,
DMP

Performance monitoring parameters

(continued)
NE-CV-BBE

NE-ES

NE-ESA

NE-ESB

NE-SES

NE-UAS

NE-PSC

NE-PJC - (
0C48).

NE-CV-BBE
NE-BE

NE-ES
NE-ESA
NE-ESB
NE-SES
NE-UAS, DMP
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Section Il: Threshold setting parameters
Threshold crossing alert parameters

Table 6-8 Threshold crossing alert parameters per supported network element

STS-3c NE-CV-BBE
NE-ES
NE-SES
NE-UAS
PPJCG
NPICG
PPJCD
NPJCD
NE-CV-BBE
NE-ES
NE-SES
NE-UAS
PPJCG
NPICG
PPJCD
NPJCD
NE-CV-BBE
NE-ES
NE-SES
NE-UAS
PPJCG
NPJCG
PPJCD
NPJCD

STS-12¢

STS-48c

STS-192c

NE-CV-BBE
NE-ES
NE-SES
NE-UAS
PPJCG
NPICG
PPJCD
NPJCD
NE-CV-BBE
NE-ES
NE-SES
NE-UAS
PPJCG
NPICG
PPJCD
NPJCD
NE-CV-BBE
NE-ES
NE-SES
NE-UAS
PPJCG
NPICG
PPJCD
NPJCD
NE-CV-BBE
NE-ES
NE-SES
NE-UAS
PPJCG
NPJCG
PPJCD

NE-CV-BBE
FE-BE
NE-ES
NE-ESA
NE-ESB
NE-SES
NE-UAS,
DMP
NE-CV-BBE
FE-BE
NE-ES
NE-ESA
NE-ESB
NE-SES

NE-UAS,
DMP

Performance monitoring parameters

(continued)
NE-CV-BBE

FE-BE

NE-ES

NE-ESA

NE-ESB

NE-SES

NE-UAS, DMP

NE-CV-BBE
FE-BE

NE-ES
NE-ESA
NE-ESB
NE-SES
NE-UAS, DMP
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Section Il: Threshold setting parameters Performance monitoring parameters
Threshold crossing alert parameters

Table 6-8 Threshold crossing alert parameters per supported network element (continued)

VT1.5 NE-CV-BBE NE-CV-BBE
(DSU/TI) FE-BE FE-BE
NE-ES NE-ES
NE-ESA NE-ESA
NE-ESB NE-ESB
NE-SES NE-SES
NE-UAS, NE-UAS, DMP
DMP
]
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Performance monitoring parameters

Section III: Trail Types

Overview
Purpose  The purpose of this section is to provide the user with the trail types
utilized by the performance monitoring feature.
Contents
Connection level and trail types. WaveStar® 6-24
BandWidth Manager, WaveStar® TDM 2.5/10G,
and WaveStar® OLS 1.6T
]
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Section Il Trail Types

Performance monitoring parameters

Connection level and trail types. WaveStar® BandWidth
Manager, WaveStar® TDM 2.5/10G, and WaveStar® OLS 1.6T

The following table shows the connection level and trail types
supported by the WaveStar® BandWidth Manager, TDM 2.5G/10G,
and WaveStar® OLS 1.6T network elements.

Connection level/trail types

Table 6-9 Connection level and trail types supported by the WaveStar® BandWidth
Manager, TDM 2.5G/10G, and WaveStar® OLS 1.6T network elements.

CKT/DL Connection Description Performance monitoring WaveStar® BWM TDM 2.5G/10G WaveStar® OLS
Trail Types 1.6T
SO STM-0 DL MSO No No No
RSO No No No
S1 STM-1 DL MS1 Yes Yes No
RS1 Yes Yes No
S4 STM-4 DL MS4 Yes Yes No
RS4 No Yes No
S16 STM-16 DL MS16 Yes Yes No
RS16 Yes Yes No
S64 STM-64 DL MS64 Yes Yes No
RS64 Yes Yes No
AU4 AU4 AU4ACTP Yes Yes No
TU3 TU3 TUSCTP No No No
TU2 TU2 TU2CTP No No No
TU12 TU12 TU12CTP No No No
El CEPT-1 DL P12 No No No
E3 CEPT-3 DL No No No No
E4 CEPT-4 DL P4 No No No
VC4S VC4 CKT VC4 No No No
VC3S VC3 CKT VC3 No No No
VC2S VC2 CKT No No No No
VC12S VC12 CKT VC12 No No No
30N CEPT-1 CKT P12 No No No
480N CEPT-3 CKT No No No No
1920N CEPT-4 CKT P4 No No No
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Section I11: Trail Types Performance monitoring parameters
Connection level and trail types:. WaveStar®
BandWidth Manager, WaveStar® TDM

2.5/10G, and WaveStar® OLS 1.6T
Table 6-9 Connection level and trail types supported by the WaveStar® BandWidth

Manager, TDM 2.5G/10G, and WaveStar® OLS 1.6T network elements.
(continued)

CKT/DL Connection Description Performance monitoring WaveStar® BWM TDM 2.5G/10G WaveStar® OLS
Trail Types 1.6T
30N VC12S-30N VC12 No No No
Combo TU1?2 No No No
480N VC3S-480n VC3 No No No
Combo TU3
672N VC3S-672N VC3 No No No
Combo (DS3) TU3
1920N VC4S-1920N VC4 No No No
Combo AU4
DS3 DS3 CKT D3 No No No
VC4-4c VC4-4c CKT VC4-4c Yes Yes No
VC4-16¢ VC4-16¢ CKT VC4-16¢ Yes Yes No
AU3S AU3 CKT AU3 Yes No No
OMS OMS CKT OMS No No Yes
OChTrail OChTrail CKT OCH No No Yes
oL OL CKT oL No No Yes
U
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Lucent Technologies
Bell Labs Innovations

I Reports Management

Overview
Purpose  This chapter describes the reports that are provided by Navis™ Optical
PM - NP.
Contents
About reports 7-2
]
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Reports Management

About reports

Introduction  Navis" Optical PM - NP supports, on demand, predefined reports to
assist you in your work activities. These reports provide data that are
not available through regular dialog boxes, forms, or network maps.

Printing reports  All predefined reports are routed to the designated printers attached to
the host.

To print a report, from the Network Map, execute Reports > Remote
Report and select the submenu for the desired report.

List of reports  The following reports are available from Navis™ Optical PM - NP
e Implementation Jeopardy Report: lists the pending facility orders
whose DXC command implementation date is in jeopardy.
*  Completion Jeopardy Report: lists the pending facility orders
whose completion date is in jeopardy.
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Numerics

15 minute time periods for
performance monitoring,
1-23

24-hour time periods for
performance monitoring,
1-23

A Acknowledge
alarm, 2-3, 4-25

Alarm List, 4-25

Traffic Correlated
Alarm List, 4-25

Affected Trail List form,
1-14

Aggregate
alarms, 1-12

Aging period for
restoration notification,
1-16

Alarm approach

fault management
operational mode, 1-7

Alarm count
view, 2-20

Alarm deletion options,
1-16

Alarm groups, 4-4

Alarm log records
archive, 2-12
delete, 2-12, 4-24
export, 2-12

Alarm propagation

Optical Network
Navigator, 4-17

Alarm settings

recommendations, 1-5
Alarm storage limits, 1-16
Alarmed objects

add to trouble tickets,
2-9

connection alarms, 4-9
equipment alarms, 4-9
external, 4-9

internal, 4-9
suppression, 4-20

termination point
alarms, 4-8

types of, 4-8

Alarms
acknowledge, 2-3
acknowledgement, 4-25

add to trouble tickets,
2-9

Lucent Technologies
Bell Labs Innovations

aggregate alarms, 1-12
alarm groups, 4-4
black box alarms, 1-12
bridge alarms, 2-16
categories, 4-6

classification, 4-4

clear with no raise
events, 4-3

collection, 4-2

color coding, 1-10
correlation, 4-8

delete, 2-11, 4-24
double raise events, 4-2
DXC alarms, 1-11
EMS alarms, 1-11, 4-4
equipment, 4-11

fault state
determination, 4-13

fault state values, 4-13
how to filter, 2-21

how to sort, 2-21

link alarms, 1-10, 2-15

network element alarms,
1-12

node alarms, 2-17

protection switch, 4-11
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raise and clear events,
4-2

regenerator alarms, 1-11

service impact
assessment, 4-22

severity, 4-7
suppression, 4-20

synchronize, 2-14, 4-3

types, 4-11

Audience, xi

Black box

alarms, 1-12
Boundary port, 4-10
Bridges

alarms, 2-16

Catalogued connection, 4-9

Clear with no raise events,
4-3

Colors

of aggregate alarms,
1-12

of alarms, 1-10

of black box alarms,
1-12

of DXC alarms, 1-11

of EMS node alarms,
1-11

of link alarms, 1-10

of network element
alarms, 1-12

of regenerator alarms,
1-11

Comments, Xxiv

Connection
catalogued, 4-9
uncatal oged, 4-9
Connection alarms
alarmed objects for, 4-9

Connection level/trail
types, 6-24

Conventions
typographical, xii
Create
trouble tickets, 2-7

Data collection

performance monitoring,
1-27

Database synchronization,
2-1

Date format
display, 3-3
Delete

alarm, 2-11, 4-24

monitoring point, 3-11

trouble tickets, 2-10

Display

installed date format,
3-3

Display Optical Network
Navigator alarmed ports,
2-23

Documentation
font usage, xii
how to comment, xiv
list of, xiii
on CD-ROM, xiii

on-line version, Xxiii

Lucent Technologies

Domain partitioning, 4-27
Double raise events, 4-2
DXC

aarms, 1-11

Element Management
Systems (EM Ss)

supported, 1-4
EMS, 1-4
EMS alarms, 1-11, 4-4

view, 2-18
Equipment alarmed object
fault state, 4-14, 4-16
Equipment alarms, 4-11
alarmed objects for, 4-9

External alarmed object,
4-9

Fault lists
2.5G, 5-4

LambdaRouter™ AOS,
5-7

Navis™ Optical EMS
management alarms,
53

Navis™ Optical PM -
NP, 5-9

0C192, 5-4
WaveStar® BWM, 5-4

WaveStar® OLS 1.6T
Family, 5-6

Fault management

accessing from Network
Map, 1-9

installation options,
1-16
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overview, 1-4
Fault management forms,
1-8, 1-13

Fault management
operational mode, 1-7,
1-16

alarm approach, 1-7
changing, 1-7, 2-4
service approach, 1-7

setting via preferences,
2-4

Fault state
direct, 4-13

equipment alarmed
object, 4-14, 4-16

indirect, 4-16

port alarmed object,
4-13, 4-16

propagation, 4-15
reassessment, 4-17

trail alarmed object,
4-14, 4-16

Fault state determination,
4-13

Fault state values, 4-13
Filter
alarms, 2-21

non-alarm events, 2-19

secondary alarms, 2-5
Font usage, xii

Forms for fault
management, 1-8, 1-13

G  Graphical Layout form,
1-13

Help

screen help, xiii

Information products
font usage, xii
how to comment, xiv
how to order, xiv
list of, xiii
on CD-ROM, xiii
on-line version, xiii
Installation options

aging period for
restoration notification,
1-16

alarm deletion options,
1-16

alarm storage limits,
1-16

fault management, 1-16

FM operational mode,
1-16

interval time, 1-16

number of events, 1-16
Intended audience, xi
Internal alarmed object, 4-9
Interval time, 1-16

Links
alarms, 1-10, 2-15

Logs

performance monitoring
message log, 1-25

Message log, 1-25
Monitoring point

delete, 3-11

Navis™ Optical EMS
management alarms, 5-3

Network elements
alarms, 1-12
behavior, 4-18
supported, 1-5

Network Event Summary,
1-13

Network Map

accessing fault
management
information, 1-9

color-coded alarms,
1-10

Nodes

alarms, 2-17
Non-alarm events

filter, 2-19
Non-boundary port, 4-10

On-line documentation, Xiii

On-line help
See: Screen help

Operational mode
See: Fault management
operational mode

Optical Network Navigator
domain, 4-27
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Optical networks

termination point
performance
parameters, 6-14

threshold crossing alert
parameters, 6-18

Ordering

information products,
xiv

Performance menu, 1-25

Performance monitoring
data collection, 1-27
data reporting, 1-29
message log, 1-25
overview, 1-21
parameters, 6-4
time periods, 1-23

Performance monitoring
data, 1-23

generate a report, 3-8

Performance parameters,
6-4

optical network
termination point, 6-14

optical threshold
crossing alert
parameters, 6-18

set threshold values, 3-6
PM Data Export, 1-24
PM Path List, 1-29
PM Port List, 1-27
Port
boundary, 4-10
non-boundary, 4-10

Port alarmed object
fault state, 4-13, 4-16

Preferences, 1-15

changing fault
management
operational mode, 2-4

Primary and secondary
alarms

suppression, 4-20
Propagation
fault state, 4-15

Protection switch alarms,
4-11

R  Raise and clear events, 4-2
Regenerators
alarms, 1-11
Reports, 7-2
create a data report, 3-8

Restoration notification,
1-16

S Screen help, xiii
Secondary alarms
filter, 2-5
Service approach

fault management
operational mode, 1-7

Service impact
values, 4-22

Service impact assessment
alarm, 4-22

Settings

user settings, 1-15

Sort

alarms, 2-21
Suppression

alarm, 4-20

alarmed objects, 4-20

Primary and secondary
alarms, 4-20

Synchronize

alarms, 2-14, 4-3

TCAs
See: Threshold crossing
alerts (TCAS)

Termination point alarms
alarmed objects for, 4-8

Threshold crossing alerts
(TCAs), 1-26, 1-29, 4-5,
6-17

parameters, 6-18
Threshold values

how to set, 3-6, 6-17

Traffic Correlated Alarm
List form, 1-13

Trail alarmed object
fault state, 4-14, 4-16

Trouble ticket, 4-28

Trouble tickets
add alarm, 2-9
create, 2-7
delete, 2-10

Typographical conventions,
Xii

Uncataloged connection,
4-9
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User settings, 1-15
V  View
alarm counts, 2-20

EMS alarms, 2-18
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